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Introduction

Introduction

Harmony has several commands, dialog boxes, and buttons. The Reference section lists all of them along with
the matching definition. To understand how to use these functions in a production context, read the User

guide.

In the Reference guide, you will learn about the various parameters available in dialog boxes, menus, nodes,

toolbars, views, and windows.

The Preferences guide provides additional details about each individual preference.
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Chapter 1: Dialog Boxes

Chapter 1: Dialog Boxes

Dialog boxes contain controls such as options and lists through which you can carry out a particular command
or task. For example, in the Scene Settings dialog box, you must indicate the resolution and alignment. A typical
dialog box looks as follows:

Advanced Save Dialog BoX ... 9
Close Gaps Dialog BoX ... L 14
Configure Line Art to Colour Art Dialog BoxX ... 15
Create Palette Dialog BoX ... 17
Create Palette from Selection Dialog BOX . . ... 18
Database Selector Dialog BoX . ... il 20
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Movie Options Dialog Box (MacOS) ... 35
Onion Skin and Light Table Transparency Dialog Box ... ... ... . . 38
Palette Browser Dialog BoX . ... 39
Palette Operations Dialog BoX . . ... L 42
Preferences Dialog BoX ...l 44
Recolour Drawings Dialog BoX . .. ... ... 47
Remove Dirt Dialog BoX . ..o 49
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Set Ease on Keyframes Dialog BoX ... 51
Tint Offset/Blend Dialog BoxX ... il 53
Toolbar Manager Dialog BoX . .. ... 54
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Advanced Save Dialog Box

In Harmony Server, the Advanced Save dialog box lets you save the scene as a new version, overwrite an
existing version, set a new current version, display a list of modified drawings, colour palettes, and modified
colour palette lists.

Palettes | Palette Lists

How to access the Advanced Save dialog Box

1. Fromthe top menu, select File > Save....

The Advanced Save dialog appears.
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Cancel

Parameter Description
» Enable this option if you want to save the modifications made to the
current scene.
Save

» Deselect the Save option if you only want to save specific components of
your scene listed in the Drawings, Palettes or Palette Lists tabs. This will
disable all option in the File tab.

This Version (number)

Saves the current version of the scene. You can rename the current version by
typing a new name into the field.

New Version (number)

Saves the current scene as a new version. You can name this new version by
typing a name into the field.

Overwrite Existing Version

Lets you select an existing version of your scene from the list to overwrite it.

Description

Use this field to add or edit an existing description for the scene version you want
to save.

Mark as Current

Lets you set this scene version as the current one. This version will be
automatically selected as the default current version when the scene is selected in
the Database Selector dialog box

10
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Drawings (Harmony Server only)

The Drawings tab lists the modified drawings.
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.
.

Cancel

Parameter

Description

Drawing list

Lets you select the modified drawings to save, and deselect the ones you do not

want to save.

Select All Selects all modified drawings in list.
Deselect All Deselects all modified drawings in the list.
Palettes Tab

The Palette tab lists the modified colour palettes.

11
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Cancel

Parameter Description

. Lets you select the colour palette to save, and deselect the ones you do not want
Colour Palette list

to save.
Show Recovered Displays the recovered palettes in the list of modified palettes.
Select All Selects all modified colour palettes in the palette list.
Deselect All Deselects all modified colour palettes in the palette list.

Palette Lists Tab

The Palette Lists tab lists all the modified colour palette lists.

12
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Palettes

)/MyEpis

Palette Lists

cene_ 001

Cancel

Parameter

Description

Palette Lists

Lets you select the modified palette list to save, and deselect the ones you do not
want to save.

Show Recovered

Displays the recovered palettes in the list of modified palettes.

Select All

Selects all modified palette lists in the list.

Deselect All

Deselects all modified palette lists in the list.

13
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Close Gaps Dialog Box

The Close Gaps dialog box lets you close up drawing areas that not are closed. This may sometimes happen
when painting. You can close small gaps in a drawing by creating small, invisible strokes between the two
closest points to close the colour zone. You do not need to trace directly over the gap. You can draw it a few

millimeters away. The two closest points automatically close the gap.

How to access the Close Gaps dialog box

1. Select View >Show Strokes or press K to see a preview of the result.
2. Toflatten the strokes you draw, click the Auto-Flatten T2 button in the Tool Properties view.
3. Select Drawing > Close Gaps or press Shift + F10 (Windows/Linux only).

The Close Gaps dialog box opens.

Parameter Description
Size Lets you set the size of the gap you want to be closed.
Apply to all drawings Closes all gaps in the drawing of the selected layer.

14
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Configure Line Art to Colour Art Dialog Box

The Configure Line Art to Colour Art dialog box lets you modify settings for the Line Art and Colour Art layers.

M Use rendered version of the drawing

for rendered image

How to access the Configure Line Art to Colour Art dialog box

1. Inthe Tools toolbar, select the Select tool.

2. Inthe Tool Properties view, hold down the Shift key and click on the Creatre Colour Art from Line

Art button.
Parameter Description
Use rendered version of the Renders the drawing and vectorize it to calculate the position of the centreline
drawing that will produce the colour art stroke.

Maximum Resolution for . .
. The size of the rendered image.
rendered image

Threshold for rendered image The value of grey processed to create the rendered vectorized arts.
Fitting error for rendered This value represents how precise the fitting of the colour art zone in relation to
Beziers the line art will be.

Lets you select the layer (Line Art, Colour Art, Underlay or Overlay) you want the
Source layer
colour art to be created from.

L Lets you select the layer (Line Art, Colour Art, Underlay or Overlay) you want the
Destination layer
colour art to be created on.

Clear Destination Art Layer Deletes the content before the colour art is added. This is useful when you
First already have artwork on the destination layer.

15
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Perform Line Art to Colour
Art Operation Immediately

Performs the Create Colour Art from Line Art command when you click OK.

16
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Create Palette Dialog Box

The Create Palette dialog box allows you to create a colour palette for your scene. Palettes created with this
dialog box are added to your scene's palette list, and stored in your scene's palette-library subdirectory.

New Palette Name: New_Palette

Palette Type: Colour

Cancel

NOTE

If you have the Advanced Palette Lists preference enabled, the dialog will also have a palette
browser, which allows you to decide where the palette is stored and whether to add it to the scene
or the element's palette list—see Palette Browser Dialog Box on page 39.

How to access the Create Palette dialog box

1. Doone of the following:
« Inthe Colour View, click the New Palette <4 button over the palette list.

o From the Colour view menu, select Palettes > New

Parameter Description

New Palette Name Allows you to type in the name of the palette to create.

Allows you choose the palette type to create:

« Colour: A colour palette can contain colours, gradients and bitmap textures.

Palette Type . . :
« Pencil Texture: A pencil texture palette can contain textures to apply as

transparency filters to pencil lines, in combination to their line colour, to create
various styles of pencil lines.

17
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Create Palette from Selection Dialog Box

The Create Palette from Selection dialog box allows you to create a palette that contains all the colours used by
all the drawings in the selected drawing layers.

-

elected Drawings

Cancel

This can be useful, for example, if the colour design for a character model or rig, a background or another kind of
asset was made using several different palettes, and you need to consolidate all of the colours used by the asset
into its own dedicated palette.

NOTES

« The Create Palette from Selection dialog uses the colours in all the drawings in the selected
layers, even drawings that are not exposed.

« For tasks related to this dialog box, see the User Guide.

How to access the Create Palette from Selection dialog box

1. Inthe Timeline, Xsheet, Camera or Node view, select one or more drawing layers.

2. Inthe top-left corner of the Colour view, open the E‘ View Menu and select Palettes > New Palette
from Selected Drawings.

Parameter Description

New Palette Name Allows you to type in the name of the palette to create.

Allows you choose one of the type of palette to create:

« Colour: Creates a palette containing all the colours, gradients and bitmap textures
Palette Type used in the selected drawing layers.

« Pencil Texture: Creates a palette containing all the pencil textures used in the
selected drawing layers.

Generate New By default, the Create Palette from Selection dialog box generates the palette by copying
Colour IDs and the colour swatches used in the selected drawings from their original palette into a new
Recolour Selected palette, along with their colour ID. This means that the colour swatches in the generated
Drawings palette will use the same colour IDs as the ones in the original palettes.

18
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If you select this option, Harmony will generate a palette with new colour IDs, and will
replace the old colour IDs in your artwork with the new ones. This will usually have no
visible effect, and will prevent the swatches in the new palette from having the same
colour IDs as the swatches you originally used to colour your artwor. When two palettes
have a swatch with the same colour ID, Harmony uses the swatch from the top-most
palette in the palette list.

NOTE

If your artwork uses Colour-Override effects, the colour IDs used by these Colour-
Override will not be replaced with the new colour IDs, making the Colour-Override
ineffective unless you reconfigure them manually. Hence, you should avoid using
this parameter if you are consolidating the palette of a character rig that uses a lot
of Colour-Overrides.

19
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Database Selector Dialog Box

The Database Selector dialog box lets you connect to your studio's central database when working on
Harmony Server.

NOTE

When you connect to the database, you cannot create new scenes directly from Harmony. The
available scenes must have been already created using the Control Center module.

Get rights to

How to access the Database Selector dialog box

1. Start Paint
2. Inthe User Name field, type in your Harmony Server username.
3. Click on OK.

The Database Selector dialog box opens.

Parameter Description
Environments Lets you select the scene's environment (project, movie).
Jobs Lets you select the scene's job (episode, sequence).

20
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Scenes

Lets you select the scene.

Get rights to modify the
scene

Allows you to modify the selected version of the scene as well as to manage and
overwrite other versions. Other users will not be able to open a different version
of the scene until you close the scene.

Get rights to modify the

scene version

Allows you to modify the currently selected scene version only. Unless the Get
rights to modify the scene option is also checked, you will not be able to change
other versions of the scene. This allows other users to modify different versions
of the scene while you are working on the selected version.

Get rights to modify all scene
assets

Automatically gets the rights to modify all of the scene's assets, locking other
users from making changes to them until you close the scene. This means that
you will have the rights to modify all the scene's versions, drawings, palettes, its
palette list, but not its library folder. If this option is unchecked, drawings and
palettes will be locked unless you unlock them manually. This can allow another
user to work on the scene's drawings and palettes in Paint while you are working
on the scene's timing or staging in Harmony.

Cache scene assets locally

Downloads the scene's drawings to your computer before opening the scene.
Harmony will then load the drawings from your computer during the session,
instead of loading them from their original location over the network. This can
significantly increase performance, especially with resource-heavy scenes.

When you save your scene, the updated drawings will be uploaded automatically
to the database, so you do not have to re-upload them manually.

NOTE

If this option is checked, it may take a while to download all of the scene's
assets when opening a particularly heavy scene.

Version

If you saved different versions of a scene, this lets you select one to open.

21
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Export OpenGL Frames Dialog Box

The Export OpenGL Frames dialog box allows you to export your scene as a sequence of images as they appear
in the OpenGL View mode of the Camera view. This means they are exported without effects, antialiasing and
proper compositing. This allows you to quickly preview the animation in your scene without having to wait
through the full rendering process.

How to access the Export to OpenGL Frames dialog box

1. Inthetop menu, select File > Export > OpenGL Frames.

Parameter Description
Output
The directory in which to export the frames or movie file.
Location You can click Browse... to open a dialog allowing you to navigate your file system and select a
directory.
The name of the file to export.
Filename If you are exporting frames, the file name of each frame will start with this value, followed by
the number of the frame.
Format
Frames Exports each frame as an individual image file.
Suffix Allows you to select the number of digits in the number used to identify each frame.

22
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Parameter Description

Specification Description

TGA Full colour
TGA1 Greyscale Truevision TGA/TARGA (*.tga)
A standard image format with lossless compression and
TGA3 Full colour support for transparency.
TGA files use more disk space than PNG files, but rendering
in TGA is faster.
Full colour
TGA4 with
transparency
Full colour /
SaGl 8 bits per
channel

Greyscale / 8
SGI1 bits per
channel

Drawing
Type

Full colour /
SGI3 8 bits per
channel

Full colour
with Silicon Graphics Image (*.sgi)
SGl4 transparency
/ 8 bits per
channel

A highly capable format with lossless compression as well
as support for double precision and transparency.

Full colour /
SGIDP 16 bits per
channel

Full colour /
SGIDP3 16 bits per
channel

Full colour
SGIDP4 with
transparency

23
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Parameter Description

Specification

/ 16 bits per
channel

Description

PSD

Full colour /
8 bits per
channel

PSD1

Greyscale /8
bits per
channel

PSD3

Full colour /
8 bits per
channel

PSD4

Full colour
with
transparency
/ 8 bits per
channel

PSDDP

Full colour /
16 bits per
channel

PSDDP1

Greyscale /
16 bits per
channel

PSDDP3

Full colour /
16 bits per
channel

PSDDP4

Full colour
with
transparency
/ 16 bits per
channel

Photoshop Document (*.psd)

An Adobe Photoshop proprietary format used for image
editing.

PSD files exported by Harmony contain a single
background layer with the rasterized image.

9) NOTE

PSD files exported from Harmony are tagged

with their colour space information in their
metadata, except for PSD files exported in
greyscale.

YUV

Y'UV frame (*.yuv)

24
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Parameter

Description

Specification

Description

A legacy format optimized for NTSC television. The image
information is encoded in the Y'UV color space, which
means Luma (Y') and Chrominance (UV).

@) NOTE

YUV images must be exported in NTSC
resolution (720 x 540), or they will not be
legible.

PAL

PAL frame (*.pal)

A legacy format optimized for PAL television.

@ NOTE

PAL images must be exported in PAL
resolution (768 x 576), or they will not be
legible.

SCAN

Toon Boom Scan Files (*.scan)

A Toon Boom proprietary format used by Scan to store
scanned image information along with its registration (peg),
resolution and field chart metadata. SCAN files are in
gresycale.

Full colour /
PNG 8 bits per
channel

Portable Network Graphics (*.png)

A highly portable image format with high lossless
compression as well as support for transparency and
double-precision. PNG is typically used for Web
applications, graphical user interfaces and image sharing.

Rendering in PNG takes more time than rendering in TGA
or in uncompressed image formats, but saves a lot of disk
space.

25
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Parameter Description
Specification Description
Full colour
with
PNG4 transparency
/ 8 bits per
channel
Full colour /
PNGDP 16 bits per @ NOTE
channel PNG files exported from Harmony are
tagged with their colour space information in
their metadata.
Full colour /
PNGDP3 16 bits per
channel
Full colour
with
PNGDP4 transparency
/ 16 bits per
channel
Jpeg (*.jpg)
A very compact image format with lossy compression. It is
IPG typically used for Web pages and photo sharing. Because it
does not preserve image quality, it is recommended to
never render in Jpeg format unless you are exporting stills
for a Web page or are making quick render tests.
BMP Full colour
Bitmap (*.bmp)
Full colour A standard uncompressed image format commonly used on
BMP4 with Microsoft operating systems.
transparency

26
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Parameter Description
Specification Description
OPT Full colour
OPT1 Greyscale L. X
Toon Boom Optimized image (*.opt)
A legacy Toon Boom proprietary format that stores bitmap
OPT3 Full colour . . .
image data with lossless compression. It supports
transparency.
Full colour
OPT4 with
transparency
Toon Boom Variable Header image (*.var)
VAR .
A legacy Toon Boom proprietary format that stores
greyscale bitmap image data with lossless compression.
Tagged Image File Format (*.tiff)
An image format with many compression and encoding
TIF settings. It is often used for image exchange in visual arts
and publishing.
TIFF images exported by Harmony are uncompressed,
encoded on a per-pixel (interleaved) basis in PC byte order.
8 bits per
channel /
DPX Full color /
RGB channel
order
Digital Picture Exchange (*.dpx)
8 bits per
channel / A professional photo format that supports various different
DPX3_8 Full color / approaches to storing colour information, which can be
RGB channel used for storing, exchanging and editing raw information
order recorded by cameras. It is commonly used in film
production.
10 bits per
channel /
DPX3_10 Full color /
RGB channel
order

27
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Parameter Description
Specification Description
12 bits per
channel /
DPX3_.12 Full color /
RGB channel
order
16 bits per
channel /
DPX3_16 Full color /
RGB channel
order
10 bits per
DPX3_10_ channel /
INVERTED_ Full color /
CHANNELS BGR channel
order
12 bits per
DPX3_12_ channel /
INVERTED_ Full color /
CHANNELS BGR channel
order
16 bits per
DPX3_16_ channel /
INVERTED_ Full color /
CHANNELS BGR channel
order
OpenEXR (*.exr)
A highly capable deep image format. Each pixel in an EXR
) ) file is exported with its Z-depth information. Additionally, if
EXR 16 lines Z.|p a pixel is semi-transparent, the color and depth information
compression of pixels further back is stored along with it. If your scene
has multiplane or 3D elements, this format can be used for
compositing your animation with other graphical elements
in 3D animation software.

28
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Parameter Description

Specification Description

@ NOTES

« OpenEXR files exported from

Harmony are tagged with the white
point and primaries coordinates for

their colour space.

« OpenEXR files are always exported by

EXR_ZIP_ 1line Zip Harmony always have 1 line Zip
1LINE compression compression if they contain a 3D
image.

Portable Document File (*.pdf)

Typically, PDF files are used to store, archive, share and
print documents. However, Harmony uses the PDF format
for its capability to store bitmap images and vector

PDE graphics.

If the write node is connected to a vector drawing layer or
to a vector composite, the exported PDF files will contain
the image as a vector graphic. It will ignore bitmap layers,
effects and deformations. Otherwise, the PDF files will
contain the rendered image as a bitmap.

Deep Texture (*.dtex)

A commonly used deep image format. Each pixel in an
DTEX file is exported with its Z-depth information.
Additionally, if a pixel is semi-transparent, the color and
depth information of pixels further back is stored along
with it. If your scene has multiplane or 3D elements, this
format can be used for compositing your animation with
other graphical elements in 3D animation software.

@ NOTE

Exporting in Deep Texture requires
RenderMan to be installed on the machine
and the path to RenderMan properly
configured in Harmony. For more information,
see the Setting 3D Renderer Paths topic of
the User Guide.

DTEX

29
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Parameter Description

Movie Exports the frames into a movie file.

Opens the movie settings dialog box for your selected video format, in which you can set the
video and audio compression settings for your video file:

o QuickTime Movie (*.mov) on Windows: Movie Options Dialog Box (macOS),

« QuickTime Movie (*.mov) on macOS: QuickTime Movie Settings Dialog Box (Windows)

oYle « Windows Media Video (*.wmv): Windows Media Video Settings Dialog Box
options .
(Windows)
@ NOTE
This button is available on Windows and macOS only.

Opens the video settings dialog box, which allows you to set the video compression settings

for your video file—see OpenQuickTime Video Options Dialog Box.
Video

options @ NOTE

This button is available on GNU/Linux only.

Opens the audio settings dialog box, which allows you to set the audio compression settings
for your video file—see OpenQuickTime Sound Options Dialog Box.

Sound

options @ NOTE

This button is available on GNU/Linux only.

Allows you to choose one of the following movie formats:

Movie « QuickTime Movie (*.mov): The Apple QuickTime format. This is the default export

Format format and is recommended for its portability, and also because it allows you to choose

among several video codecs.

30
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Parameter Description

@ NOTES

« On Windows, Apple QuickTime must be installed to allow Harmony

to export QuickTime movies. You can configure the export of
QuickTime movies to use any codec that is compatible with
QuickTime, including H.264, MPEG-4 and Animation.

On macOS, Harmony uses Apple AVFoundation to export QuickTime
movies, which allows you to export using codecs such as H.264,
Apple ProRes 422 and Apple ProRes 4444, among others.

If you are looking to export a QuickTime movie with transparency, be
sure to choose a codec that supports encoding with an alpha channel.

On GNU/Linux, Harmony uses the OpenQuickTime library to export
QuickTime movies. This only allows you to export videos in non-
proprietary formats such as Motion-JPEG, Photo JPEG, PNG or
Uncompressed (RGB).

« H.264/MPEG-4 (*.mov) : A simple movie format that uses the H.264 codec, which is
supported by most web browsers.

@ NOTES

Using this format does not require additional software. However, if
this is the first time you export a movie in H.264/MPEG-4 format, you
will be prompted to download the OpenH264 library from Cisco.
Simply click Yes when prompted, and Harmony will automatically
download the library, then export the movie.

There are no encoding options for this format.

This format supports resolutions of up to 4096x2304. Each
dimension must be a multiple of 16 pixels.

Audio exported in this format is encoded in PCM 16-bit stereo, 22.05
kHz.

« Windows Media Video (*.wmv): The native format for Windows Media Player.

@ NOTES

Windows Media Video (.wmv) files can only be exported on
Windows.

Video players and editors on non-Windows systems can generally not
open Windows Media Video (.wmv) files.

o Flash (.swf)

31
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Parameter Description
« Image sequence in Jpeg (.jpg), Targa (.tga) or Portable Network Graphics (.png)
format.
Options
If checked, the exported images or movie will be opened after the export is finished:
Openin . . . I
PI « If you are exporting frames, they will be opened in the Play application.
ayer
« If you are exporting a movie, it will be opened in your operating system’s movie player.
Allows you to specify a resolution to export in, relative to your scene's actual resolution:
« Same as Scene Resolution: Exports a movie in the same resolution as your scene's
resolution.
« 3/4 of Scene Resolution: Exports a movie at 75% of the scene's width and height.
Resolution
« 1/2 of Scene Resolution: Exports a movie at 50% of the scene's width and height.
« 1/4 of Scene Resolution: Exports a movie at 25% of the scene's width and height.
« Custom: Allows you specify the preferred resolution of your exported video file, in
pixels, in the Width and Height fields.
Allows you to specify the range of frames in your scene to export:
« All Frames: Exports all the frames in your scene.
« From/ to: Allows you to specify the frame range to export using the two input fields to
the right. The first input field is for specifying the first frame to export, and the second
R one is for specifying the last frame to export. All the frames in-between, including the
ange
d ones specified, will be exported.
« Current Frame: Exports the current frame only.
« Selected Frames: Allows you to select which frames to export. You can enable or
disable exporting a specific frame by clicking on it. You can also toggle exporting a
range of frames by clicking and dragging over that range in the list.
OK Exports OpenGL frames with the selected settings and closes the dialog box.
Cancel Closes the dialog box without exporting anything.
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Manage Local Cache Dialog Box

The Manage Local Cache dialog box displays a list of all the Harmony Server scenes for which you have cached
drawings. In this dialog, you can check if the drawings you have in a scene's cache match the drawings in the
database server, you can delete unused caches and you can change the directory in which scene data is
cached.

—[ List of scene caches I

NOTE

A scene's data is cached on your computer when you check the Cache scene assets locally option
in the Database Selector before opening the scene—see Database Selector Dialog Box on page 20.

How to access the Manage Local Cache dialog box

1. Inthetop menu, select File > Manage Local Caches.

The Manage Local Caches dialog appears.

Parameter Description
The list of caches stored on your computer. There is one item for each scene for which there is
cached data. Each item is identified by the scene's environment, followed by its job, then its name, in

List of this format:

scene Environment/Job/Scene

caches . . . . .
If you select a scene cache in the list, the Manage Local Caches dialog will compare the drawings
that are cached on your computer to the drawings in the actual scene in the database, and report if
they are identical or not in the Local Cache Status field.

Local If you select a cache, the Manage Local Cache dialog will analyze whether the data in the selected
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Parameter Description

cache matches the data in the actual scene in the Harmony Server database.

If it displays Scene's Local Cache is identical to the database, then the drawings in the selected
cache on your computer are identical to the drawings in the corresponding scene in the database,
meaning that your cache and that the database are up to date.

If it displays Scene's Local Cache is different than database, then some drawings in the selected
cache on your computer are different from the drawings in the corresponding scene in the database.
This usually means one of the following:

Cache

Status « If the selected cache is the cache of the currently opened scene and you just saved your
scene, Harmony may still be uploading the updated drawings to the database. In this case,
you can close the dialog, wait a few seconds, and reopen it to see if Harmony is done
uploading the drawings. If it is, it will report that the cache is identical to the database.

« If this is not the cache of the currently opened scene, it is likely that the database scene has
been changed by someone else since the last time you opened it. That would mean that the
database version is more up to date than your cache. This is not a problem, as next time you
open the scene, your cache will be updated.

Local

Cache Indicates where scene caches are stored on your computer. By default, scene caches are stored in a
Root folder named Toon Boom Harmony Local Cache, inside your Documents folder.

Folder

Allows you to change the folder where caches are downloaded when you open a scene.

@ NOTE
Browse

The caches that are currently stored on your machine will not be moved to their new location.

Hence, when you change the local cache root folder, the list of scene caches will become
empty until you open a scene.

Deletes the selected scene cache from your computer.

Remove @ NOTE

This button is greyed out if the selected scene cache is for the currently opened scene, as this
cache is currently in use by Harmony.

Close Closes the dialog.
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Movie Options Dialog Box (macOS)

The Movie Options dialog box allows you to configure the video and audio settings when exporting a movie in
QuickTime Movie (.mov) format on macOS.

[ NN ] Movie Options

Video

Alpha: B

¥ Sound

Rate:

@ Mono @ Stereo

NOTES
« For tasks related to this dialog box, refer to the User Guide.

« Thisdialog can only be accessed on macOS.

How to access the Movie Settings dialog box

1. From the top menu, select File > Export > Movie.
The Export Movie dialog box appears.
2. Inthe Movie Format drop-down, select QuickTime Movie (*.mov).

3. Click on the Movie Options button.

How to access the Movie Settings dialog box from the Export OpenGL Frames dialog

1. Inthe top menu, select File > Export > OpenGL Frames.
The Export OpenGL Frames dialog box appears.
2. In the Format section, select Movie.
3. Inthe Movie Format drop-down, select QuickTime Movie (*.mov).

4. Click on the Movie Options button.
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Parameter Description

Video

Allows you to select which algorithm to use to compress the video data. The following video
codecs are supported:

o H.264: A very effective lossy compression algorithm that is commonly supported by web
browsers and media players.

« H.265: Same compression quality as H.264, but with a smaller compression size. This is
useful for videos intended for the web and mobile devices. Not supported on all major
browsers or operating systems.

o Apple ProRes 422: A nearly lossless compression algorithm commonly used for video
editing on Apple systems. This codec is optimized for preserving video quality, but not
for publishing or streaming.

Codec « Apple ProRes 422 HQ: Preserves visual quality at the same high level as Apple ProRes
4444 but for 4:2:2 image sources (cleaner footage for things like green screening).
Heavier than Apple ProRes 422 for real-time editing performance.

o Apple ProRes 422 LT: A more highly compressed codec than Apple ProRes 422, with
roughly 70 percent of the data rate and 30 percent smaller file sizes. This codec is perfect
for environments with limited storage capacity and data rates.

o Apple ProRes 422 Proxy: An even more highly compressed codec than Apple ProRes
422 LT, intended for use in offline workflows that require low data rates but full-
resolution video.

o Apple ProRes 4444: A nearly lossless compression algorithm commonly used for video
editing on Apple systems. Compared to Apple ProRes 422, this codec preserves more
colour detail and supports transparency. However, it results in heavier file sizes.

Check this option if you want to export a video with transparency.

Alpha NOTE

This option is only available when exporting with the Apple ProRes 4444 codec. Other
codecs do not support transparency.

Sound Uncheck this checkbox if you want to export a movie without an audio track.

Rat Allows you to select the sample rate, or frequency, in which to export the audio track for the
ate .
movie.
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Parameter Description

(2 o
Harmony cannot export audio at a higher sample rate than 22.050 kHz. If you select a
higher sample rate, your project's audio will be upsampled, which means it will take more

disc space without increasing in quality.

Allows you to select whether to export the movie's audio track using the Mono or Stereo channel

mode.
Use @ NOTE
Stereo sound has a separate track for the left and right speakers, whereas mono sound
only has a single audio track for all speakers.
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Onion Skin and Light Table Transparency Dialog Box

T-ANIMPA-006-009

This dialog box lets you adjust the Onion Skin and Light table transparency parameters.

How to access the Onion Skin and Light Table Transparency dialog box

o Inthe Drawing view toolbar, click on the Top Light *~ button to open the Onion Skin and Light
Table Transparency dialog box.

Command Description

Sets the maximum opacity value for the onion skin opacity display. Moving the
Onion Skin Opacity slider all the way to the left = 0% opacity. Moving the slider all the way to the
right = 100% opacity.

Sets the maximum opacity value for the light table display. Moving the slider all
Lighttable Opacity the way to the left = 0% opacity. Moving the slider all the way to the right =
100% opacity.

Sets the washed-out value for the light table display. Moving the slider all the
LightTable Wash way to the left = 0% opacity. Moving the slider all the way to the right = 100%
opacity.

. Sets the maximum opacity value for the background wash. Moving the slider all
Bitmap Background . . . .
the way to the left = 0% opacity. Moving the slider all the way to the right =

Wash . .

100% opacity. Only works for bitmap layers.

Sets the maximum opacity value for central vector lines (lines made by the
Pencil Lines Opacity Pencil or Shape tools). Moving the slider all the way to the left = 0% opacity.

Moving the slider all the way to the right = 100% opacity.
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Palette Browser Dialog Box

The Palette Browser dialog allows you to decide the level of palette list and palette storage to use when you
want to create, clone, link to or import a palette.

This dialog only appears if you have the Advanced Palette Lists preference enabled, which is disabled by
default. When Advanced Palette Lists mode is disabled, Harmony automatically stores palettesin a scene's
palette list, inside the scene's palette-library subdirectory.

Harmony Server Harmony Stand Alone

How to access the Palette Browser dialog box

1. Start Paintand login.
2. Close the Database Selector dialog box.
3. Fromthe top menu, select Tools > Palette Operations.

4. Inthe Palette Operations dialog box that opens, select the palette you want to clone at the location
and level in which it was stored.

5. Click Clone.

Parameter Description

This allows you to browse for the physical location of the palette file in your

Palette Location database.

If you are using Harmony Stand Alone, you can still select the scene's own job or
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environment as a location. Stand alone scenes have a provisional job and
environment storage space inside the scene's directory. The files in these storage
spaces can be imported into a database scene's actual job and environment when
importing the scene to a Harmony database. If you never intend to use Harmony
Server, you should keep your palettes inside your scene or element's palette
libraries.

Environment

Stores the palette file in the selected environment's palette library. Environments
are typically used to contain a whole production, series or feature film.

« In Harmony Server, this stores the palette in /USA_DB/environments/

[environment name]/palette-library.

« In Harmony Stand Alone, this stores the palette inside the scene's
directory, under environments/Digital/palette-library.

Job

Stores the palette file in the selected job's palette library. Jobs are typically used to
contain episodes in a series, or any set of scenes that is intended to be put in the
same sequence.

e InHarmony Server /USA_DB/jobs/[job name] /palette-library.

« In Harmony Stand Alone, this stores the palette inside the scene's
directory, under jobs/Digital/palette-library.

Scene

Stores the palette file in the selected scene's palette library, which is the
palette-library subdirectory of the scene's directory.

Element

Stores the palette file inside the selected element's palette library. This library is
located inside the scene's directory, under elements/ [element
name] /palette-library.

Palette

This lists the existing palettes in the selected location.

New Palette Name

If you are creating or cloning a palette, use this field to enter the palette file's
name. The palette will be listed under this name in your palette list. On your file
system, it will be named after its palette name, followed by the extension .plt.

Palette Type

When creating a palette, you can choose between the following palette types:

« Colour: A colour palette can contain colours, gradients and bitmap
textures.

« Pencil Texture: A pencil texture palette can contain textures to apply as
transparency filters to pencil lines, in combination to their line colour, to
create various styles of pencil lines.
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Palette List

This allows you to decide if you want the palette to be added to your scene's
palette list, or to the currently selected element's palette list.

Scene Palette List

Adds the palette to the scene's palette list. Palettes in the scene's palette list are
available to all the elements in your scene. This is especially useful if you are
doing digital animation, where character models can be made of many layers that
need to use the same palette.

Element Palette List

Adds the palette to the currently selected element's palette list. Palettes in an
element's palette list can only be used by the drawings in this element, and will
only be listed in the Colour view when this element is selected. This can be useful
if you are doing traditional animation, where each character is usually drawn on a
single layer, and you want each layer to have its own palette.
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Palette Operations Dialog Box

When you start Toon Boom Harmony connected to the database, you can access the Palette Operations dialog
box which lets you clone, rename, or delete palettes in your database, without having to open a scene or
browse the database's file system in your operating system's shell.

In Harmony, palettes are individual * . p1t files that can be copied, transferred and stored. When a palette is
created from Harmony, it needs to be stored somewhere. By default, the palette file is stored in the scene
directory in a palette-library folder unless you specify a different location.

There are four locations where you can find palette-library folders: Element, Scene, Job and Environment.

How to access the Palette Operations dialog box

1. Start Paintand login.
2. Close the Database Selector dialog box.

3. Fromthe top menu, select Tools > Palette Operations.

Parameter Description

Environment The production, project, feature film or series.

Job The episode and sequence from each environment.
Scene The scenes from each job.

Element The layers and columns in each scene.

Palette The scene palettes.

Description Notes, if any, of the project.
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al Opens the Palette Browser dialog box from which you can select the level in
one
which to store the palette file.
Rename Lets you rename a palette.
Lets you delete a palette.
Delete NOTE
It is not recommended to disable the warning message that appears when
you are attempting to delete a palette as this operation cannot be undone.
Close Closes the Palette Operations dialog box.
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Preferences Dialog Box

The Preferences dialog box allows you to adjust preferences to suit your workflow and your production's needs.

General

NOTE

For a list of all the preferences as well as their functionality, refer to the Preferences guide.

How to open the Preferences dialog box

1. Doone of the following:
» Windows or GNU/Linux:

« Inthetop menuy, select Edit > Preferences.

e Press Ctrl + U.
« macOS:

« Inthe top menu, select Harmony [Edition] > Preferences.

e Pressdf +U.

Paramete

Description

r

Preferenc This drop-down allows you to select among one of the available preference presets.
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Paramete

Description
r

Tab /
Location

Preference

Focus on
Mouse
Enter

The different preference presets have a lot of settings in common. The following table lists how each
preset differs for specific preferences:

Compositin
9

Preference Set

Cutout Paperless Riggin
Animatio Animatio <k

9

General

Default
Separate
Position for
Pegs

e Set

Stop-
Motion
Keyframes

Reduce
Indentation

Timeline

Drawing
Substitutio
n: Create
Key
Exposure

On

Support
Overlay and
Underlay
Arts

Advanced

Advanced
Palette List

Advanced
Element
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Paramete

Description

r

Preference Set

Tab /
i Rreference Cutout Paperless
Location Compositin . . pe .
Animatio Animatio
< n n
Mode
Element
Node
Animate
) On On Off On Off
Using
Animation
Tools
Pencil
Tool Auto CI
oo uho Hlose on on on On off
Propertie Gap
s
Save... Allows you to export your current preference settings as an XML file, which you can import later.
Load... Allows you to browse for and import a preference file that was exported with the Save... button.

Where you can browse for and change preferences.

Preferenc

e Tabs @ NOTE

For a list of all the preferences as well as their functionality, refer to the Preferences guide.

Restore

All Restores all your preferences to their default setting for the selected preference set.
Defaults

OK Commits your changes to the preferences and closes the dialog.

Cancel Undoes your changes to the preferences and closes the dialog.
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Recolour Drawings Dialog Box

The Recolour Drawing dialog box allows you to replace all instances of a colour or texture in drawings with a
different colour or texture swatch in one of the scene's palettes. This replaces the colours or textures in the
drawings without requiring you to modify the palettes. You can use this dialog to perform colour replacement in
the current drawing, in all the drawings in one or several layers or in all drawings in your scene.

This dialog will replace the colour or texture that is currently selected in the Colour view with the colour or

texture that you select inside the dialog.

How to access the Recolour Drawings dialog

1. Inthe Colour view, select the colour or texture swatch you want to replace by doing one of the

following:

« Select the palette in which the colour or texture swatch is located, then select the swatch you

wish to replace.

o Ifthe drawing in the Camera or Drawing view contains the colour or texture you want to
replace, select the Colour Eyedropper 2 tool in the Tools toolbar, then click on that colour or
texture in the drawing. The Colour view will automatically select that colour or texture's
palette as well as that colour or texture's swatch.
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2. Doone of the following:
« Right-click on the swatches list, then select Recolour Drawings.

o Open the Colour view menu E‘, then select Colours > Recolour Drawings.

Parameter Description

Allows you to select which drawings will be affected by the colour replacement:

« Current drawing: Replaces the selected colour in the currently selected
drawing only.

« All drawings in the currently selected layers: Replaces the selected colour
in all the drawings in the layer that is currently selected in the Timelime or

Xsheet view.
Replace Colour In

NOTE

This option can work with several drawing layers selected.

« All drawings in the scene: Replaces the selected colour in every drawing
in the current scene.

Allows you to select the palette and colour or texture swatch to replace the
Replacement Colour .
selected colour or texture with.
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Remove Dirt Dialog Box

The Remove Dirt dialog box lets you select small dots and hairs on a drawing for removal.

Cancel

When paper drawings are passed through a scanner, there can be some hair and dirt scattered across them.
These lines and dots need to be cleaned. Harmony provides different tools to help get rid of them quickly.

How to access the Remove Dirt dialog box
1. Doone of the following:

o From the top menu, select Drawing > Remove Dirt.

e Press Shift + D.

Parameter Description

Lets you adjust the amount of detail removed from the layer.

Raising the Remove Dirt level will select bigger dots. When selecting larger dots,
be careful not to lose small details like pupils and nostrils. Once you have chosen

Slider
the level, you can apply it to the current drawing or the entire animation sequence.
This is a quick way to get rid of most dirt and dust.
During this process, the dirt that will be removed is highlighted in red.

Apply to all drawings Applies the operation to all drawings in the layer.
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Remove Hair Dialog Box

The Remove Hair dialog box lets you remove any small strokes created in the Colour Art layer from very thick
lines or filled zones. Increasing the Remove Hair level value will select larger strokes for removal from the
drawing.

Cancel

When paper drawings are passed through a scanner, there can be some hair and dirt scattered across them.
These lines and dots need to be cleaned. Harmony provides different tools to help get rid of them quickly.

How to access the Remove Hair dialog box
1. Select the drawing containing the drawing to clean.

2. Fromthe top menu, select View > Show Strokes to display the invisible lines or press K.

3. Inthe top menu, select Drawing > Remove Hair.

Parameter Description
Slider Lets you adjust the number of length of hairs selected.
Apply to all drawings Applies the operation to all drawings in the layer.
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Set Ease on Keyframes Dialog Box

The Set Ease on Keyframes dialog box allows you to quickly change the percentage of ease before and after a
selection of keyframes.

This dialog box is designed to quickly adjust the “time ratio” of the ease on your animations. To give you a better
idea of its effect, select a keyframe and open the Set Ease for Multiple Paramters dialog box. This dialog box
allows you to adjust the ease of your animations using Bezier handles. Moving the Bezier handle laterally
changes the time ratio of the ease, and moving it vertically changes its value ratio—see Set Ease for Multiple

Parameters Dialog Box.

EEAQ
EEAaA@

[ What the Set Ease on Keyframes dialog box does. I What the Set Ease on Keyframes dialog box does
NOT do.

How to access the Set Ease on Keyframes dialog box

1. Inthe Timeline view, select one or several animation keyframes.
2. Inthe Timeline toolbar, click on the 7 Set Ease on Selected Keyframes button.

The Set Ease on Keyframes dialog box appears.

Parameter Description

Ease In Allows you to adjust the ease left of the selected keyframes.

(left) « If the checkbox is unchecked, the ease left of the selected keyframes will be unchanged.
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Parameter

Description

« If the checkbox is checked, the ease left of the selected keyframes will be set to the
percentage in the input-field right of the checkbox.

Allows you to adjust the ease right of the selected keyframes.

Ease Out « If the checkbox is unchecked, the ease right of the selected keyframes will be unchanged.

right

(right) « If the checkbox is checked, the ease right of the selected keyframes will be set to the
percentage in the input-field right of the checkbox.

OK Applies the selected changes and closes the dialog box.

Cancel Closes the dialog box without making any changes.
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Tint Offset/Blend Dialog Box

You can offset, blend, or mix the colours in a colour palette using the sliders and increasing the Amount value.

Click Apply to implement the
modification to your palette.

Click the colour swatch to
change the tintin the Colour
Pickerwindow

Click Reset button to
reset the transformation.

How to access the Tint Offset/Blend dialog box

1. From the Colour View menu, select Palettes > Tint Panel or right-click and select Tint Panel.

The Blend/Offset Tint panel opens.

Parameter

Description

Offset

Offsets the selected colours by the adjustments made using the HSB and RGB
sliders. Use the Amount slider to adjust the degree of offset. Use the Alpha slider
to adjust the opacity of the selected colour.

Blend

Blends the selected colours with the colour swatch in the top-right corner. Use
the Amount slider to adjust the degree of blend. A blend of 100% turns the
selected colours into the same colour as the swatch. Adjusting the HSB and RGB
sliders affect the swatch colour, which in turn affects the selected colours on the
left. Use the Alpha slider to adjust the opacity of the swatch.

Mixer

Select a Base and Tint colour to form a third colour swatch. Use the slider just
beneath to mix the Base and Tint colours by different amounts. This will affect the
mixed swatch whether it is selected or not. Select either the Tint or Base swatch
and use the HSB and RGB sliders to adjust its colour. This will affect the mixed
swatch colour, which in turn affects the selected colours on the left.
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Toolbar Manager Dialog Box

The Toolbar Manager dialog box lets you customize the toolbar in any of the views. You can add your favourite

tools to a toolbar for an efficient workflow.

ng Medium

Small
L3

Default oK. Cancel

How to access the Toolbar Manager dialog box

1. Right-click on a toolbar in any view and select Customize. Note that the menu will not appear if you

right-click on a disabled icon.

Parameter Description

Available Tools Displays the complete list of tools available for customizing a toolbar.
Toolbar Displays a list of the tools currently available on the toolbar.

Default Restores the toolbar with its default items.
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Chapter 2: Tools Properties

Harmony has a wide variety of drawing and manipulation tools and each one of them has a series of options
and modes available in the Tool Properties view. This section covers these options.

Tool Properties == | %

Brush Tool Properties ... 58
Centerline Editor Tool Properties ... o 79
Close Gap Tool Properties . ... 81
Colour Eyedropper Tool Properties ... .. L 82
Contour Editor Tool Properties .. ... 83
Cutter Tool Properties . ..o 88
Drawing Pivot Tool Properties . . ... 93
Edit Gradient/Texture Tool Properties . ... ... ... 95
Ellipse Tool Properties . ... oL 96
Envelope Tool Properties . ... 106
Eraser Tool Properties .. .. oo 109
INK TOOl Properties .. L 130
Line Tool Properties . ... 132
Paint Tool Properties ..o 144
Pencil Tool Properties . 151
Pencil Editor Tool Properties ... .o 162
Perspective Tool Properties .. ... 167
Polyline Tool Properties ... .. . 170
Rectangle Tool Properties . ... ..o L 178
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Reposition All Drawings Tool Properties ... ... 188
Select ToOol Properties .. ... 190
Shift and Trace Tool Properties .. ... L 202
Smooth Editor Tool Properties ... L 205
StamP TOOl Properties oL 207
Stroke Tool Properties . ... . 215
Text ToOl Properties ... 217
Z00mM ToOl Properties ..o 220
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Brush Tool Properties

The Brush tool allows you to draw by creating shapes based on your drawing strokes and filling them with
colour or textures. When used with a tablet, it is pressure sensitive, just like a real life brush.

How to access the Brush tool properties

1. Inthe Tools toolbar, select the Brush & tool.

The tool's properties are displayed in the Tool Properties view.

Solid Brush 1
5

Solid Brush 2
10

Solid Brush 3
15

Solid Brush 4
25

Fixed Width 1
1

Brush Properties

The following properties affect the brush's size, smoothing and other properties for the drawing style of your
brush. Those properties can be saved into brush presets for later use.

Property Description

The Preview area lets you see a preview of the stroke your drawing tool will make.

Preview Area

- /\/ I

Brush Properties Dialog The arrow button right of the preview area opens the Brush Properties dialog.
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Description

. /\-/ I

While the Tool Properties view only gives you access to a few of the brush
properties, a list of brush presets and other drawing options, the Brush Properties
dialog gives you access to all the available options for your brush's tip and texture.
For more information on the Brush Properties dialog, see the Brush Properties Dialog

section below.

Defines the maximum width of brush strokes.

If the tool is used with a pressure sensitive pen tablet, the width of the stroke will
Maximum Size vary between its maximum size and minimum size depending on the amount of
pressure used. If used with a mouse, the width of the stroke will always be its

maximum size.

Allows you to set the opacity for each instance of the brush tip that gets printed into
your canvas. Contrary to the Opacity parameter, the flow parameter has a cumulative
effect. This means that a lower flow will make your brush strokes more transparent
towards its extremities and more opaque in its center. Your stroke's flow will also
accumulate if you draw over it. By default, your brush's flow varies with the amount
of pressure you put on your tablet pen.

@ NOTE

This option is only displayed in the Tool Properties view when drawing on a

Flow

bitmap layer.

The Opacity parameter are where Lets you set the opacity of your brush strokes.
Contrary to the Flow parameter, the Opacity parameter is non-cumulative. Your
whole brush stroke's opacity will not exceed the Opacity parameter. By default, the
Opacity parameter varies depending on the amount of pressure you put on your
tablet pen.

@ NOTE

This option is only displayed in the Tool Properties view when drawing on a

Opacity

bitmap layer.

Brush Presets

These options allow you to select, create and manage brush presets.
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Icon Property Description

By default, Harmony has preloaded brush presets. You can also create
your own brush presets by configuring your brush, then saving its
properties into a new preset. It is also possible to export and import brush
presets.

Solid Brush 1
5
Presets list Solid Brush 2
10

Solid Brush 3
15

Solid Brush 4
25

Fixed Width 1
1

Fixed Width 2
10

New Brush Preset Creates a new preset based on the current tool properties.

» Delete Brush Deletes the currently selected preset.

Open a menu that contains the following options:

« New Brush Preset: Creates a new preset based on the current tool
properties.

« Delete Brush: Deletes the currently selected preset.

« Rename Brush: Allows you to rename the currently selected
preset.

« Import Brushes: Allows you to import brush presets exported

from Harmony.
E Brush Presets Menu

« Export Brushes: Allows you to export your brush presets into an
.xml file.

« Small Thumbnail: Displays presets in a grid of small thumbnails
with a preview of their tip.

« Large Thumbnail: Displays presets in a grid of big thumbnails,
with their name and a preview of their tip.

« Stroke View: Displays presets in a list, with their name and a
preview of a stroke done with each preset.
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Drawing Options

These options affect the way your drawing strokes are added to your artwork.

Icon Property Description

When enabled, your brush strokes will appear behind the existing
artwork.

The orange stroke was drawn
over the black stroke, then put
underneath it.

& Draw Behind

NOTE

Your brush stroke will temporarily appear over your artwork as
you draw it, until you release the mouse cursor or tablet pen.

When enabled, drawing a closed shape will automatically fill it with the
currently selected Paint colour.

TIP

‘ Auto Fill By default the pencil line and its fill will be the same colour. To
select different colours for the line and its fill, do the following:

1. In the Colour view, click the < Unlock Three Colours
button.

2. Click on the 4 Set Current Brush Colour swatch. Then,
in the colour list, select the desired colour swatch for
your outline.

3. Click on the ® Set Current Paint Colour swatch. Then,
in the colour list, select the desired colour swatch for the
fill.

When enabled, your brush strokes will only repaint existing artwork and
will not add colour to empty areas. If you repaint semi-transparent

(S

Repaint Brush
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artwork, your artwork will not become more opaque than it already is.

Automatically Create
Colour Art

As you draw in the Line Art layer, the Automatically Create Colour Art
option instantly creates the corresponding strokes in the Colour Art layer.

NOTE

This option is only available when drawing on a vector layer.

i

Auto-Flatten Mode

By default, when drawing on a vector layer, each new stroke is created as
a separate drawing object, which can be edited independently from other
parts of the artwork. When enabled, the Auto-Flatten option
automatically merges strokes into existing artwork.

NOTE

This option is only available when drawing on a vector layer.
When drawing on a bitmap layer, artwork is always flattened.

Snapping

Allows you to enable or disable snapping for this tool and all other
animation and drawing tools that support snapping, as well as to select
which types of snapping are enabled.

If you double-click or long-click on this button, it will open a pop-up
menu in which you can toggle different snapping modes. You can also
click on this button to toggle it off, which will disable all snapping modes,
and click on it again and toggle it on to re-enable the snapping modes
which were previously enabled.

This tool supports the following snapping mode:

« Snap to Alignment Guides: While drawing, the drawing tool will
snap against nearby alignment guides.
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Respect Protected
Colour

In the Colour view, it is possible to make some of the colours in your
palettes protected from change. When enabled, the Respect Protected
Colour option will prevent the brush tool from drawing over areas filled
with a protected colour.

NOTE

This option is only available when drawing on a vector layer.
When drawing on a bitmap layer, colour is not linked to your
palettes and cannot be protected.

]
(m]m]

Use Stored Colour
Gradient

The Use Stored Colour Gradient option can be used when painting with a
gradient colour to always position the gradient in the same way it was
stored, making it consistent across brush strokes. You can store a
gradient by selecting a zone painted with a gradient with the Select tool,
then clicking on Store Colour Gradient D' in the Tool Properties view.

NOTE

This option is only available when drawing on a vector layer.

Brush Properties Dialog

Brushes have an extensive set of options and properties that are not displayed in the Tool Properties view, but
rather, in a dialog you can access from it. To open the Brush Properties dialog, click on the arrow button right of

the stroke display area.

/\/

The Brush Properties dialog has five different tabs, minus the Smoothing tab if you are working on a bitmap
layers. Below is detailed information about the options available in each tab:

o Tip Tab on page 63

« Smoothing Tab on page 69

e Transparency Tab on page 69

e Dual Tip Tab on page 73

o Paper Texture Tab on page 76

Tip Tab

The Tip tab allows you to configure the shape, size, hardness and spacing of your brush tip.
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Diamond | Square

Property Description

Allows you to select between one of the following brush types:

« Solid Vector Brush: Creates vector shapes filled with a solid colour.
Makes artwork lightweight, scalable and easy to tweak. Since this kind of
brush can only create solid colour shapes, solid vector brushes have a
limited set of options including size, roundness, angle, centerline
smoothing and contour smoothing.

o Textured Vector Brush: Creates vector shapes filled with a texture. This
Brush Type gives you access to bitmap brush tips, paper textures, transparency and

several other options.

NOTE

This option is not available when working on a bitmap layer. With bitmap
layers, brushes are always textured, and textured brush options are
always available.

64



Harmony 20 Paint Reference Guide

Brush Tip Library

Diamond | Square | Brush01 | Brush02

4 L

Brush(4 | Brush05 | Brush06 | Brush07 = Tip_01

co0er

Tp02 | Tip03 | Tip04 | Tip 05 | Tip 06
S

This is where you select the shape of the brush tip. By default it is round. Note
that some tips are designed to have semitransparent areas, even when the
maximum brush opacity is set to 100%.

To create a custom brush tip, you must prepare the file ahead of time, either in
Harmony or in a third-party software, such as Adobe Photoshop. Colour is not
supported and transparency is not supported in the traditional sense. Black
appears as 100% opaque, white appears as 100% transparent and all the shades
of grey in between appear as varying degrees of semitransparency. A range of file
formats are supported—.jpeg, .png, .tif, .psd, .tga to name a few. Alpha channels
are disregarded on import. It is recommended that your file be between 100 x
100 pixels and 400 x 400 pixels.

You can also import brush tips that you exported from Harmony, so you can
share them with colleagues.

Minimum and Maximum Size

The minimum and maximum sizes of your drawing tool produce the thick and
thin effect on your stroke. This works with the pressure sensitivity of a pen
tablet.

o Maximum Size: Defines the maximum width of the stroke.

o Minimum Size: Defines the minimum width of the stroke in relation to

and as a percentage of the maximum size.

NOTE

Setting the Minimum Size value to 100% eliminates the possibility of
creating width variation on your stroke. In other words, you would be
forcing a uniform line width using the Maximum Size value.

Proportional to Camera

If you check this option, the size of the brush will be adjusted to the position of
the camera on the z-axis. This means that if the camera is zoomed in on the
scene, the brush will be proportionally smaller so that it appears the same size in
the rendered image. Likewise, if the camera is zoomed out, the brush will be
proportionally bigger.

Roundness and Angle

The Roundness and Angle parameters allow you to change the shape and
orientation of the tip.
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o Roundness: The vertical scaling to apply to the tip. Reducing this setting
squashes the tip vertically, allowing you to turn round or square tips into

flat tips.

« Angle: The angle at which to rotate the brush tip, counterclockwise.

NOTE

The squashing is not relative to the angle—if the tip is rotated, the
squashing will still be done relative to the tip's original orientation.

[ | - » Vs
Roundness: 100% Roundness: 33% Roundness: 100% Roundness: 33%
Angle: 0° Angle: 0° Angle: 457 Angle: 457

Pen Tilt Sensitivity

If your pen and tablet support tilt sensitivity, this option allows you to set
whether your brush takes your pen's tilt angle into account, and how much.

When your pen is fully tilted, your brush tip will be stretched by the percentage
you set in this parameter, in the angle in which you tilt it. For example, if you set
the Pen Tilt Sensitivity to 50%, and you tilt your pen all the way up or down, your
brush tip will be stretched vertically by 50%. With the same setting, if you tilt
your pen all the way left or right, your brush tip will be stretched horizontally by
50%.

N/

Pen tilted up or down

/\/

Pen tilted left or right

Use Pen Rotation

If enabled, and if your pen and tablet support tip rotation, your brush tip will
rotate with the angle of your pen tip.

A stroke with a square tip without pen rotation

A stroke with a square tip with pen rotation,
with the pen rotated at 45°
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Hardness

The hardness value corresponds to the softness of the brush tip's edges. The
lower the value, the softer the tip edge. The higher the value, the sharper the tip
edge. Be aware that some brush tips are not 100% opaque, so they will always
appear somewhat soft, even at 100% hardness.

w *

100% Hardness 10% Hardness

Spacing

Defines the amount of space between each stamp of the brush. A value of 100%
sets the stamp marks edge to edge, if there is no white space around the shape.
The larger the value, the greater the space between marks. A really large value
can make the brush stroke appear as a string of individual marks. Conversely, a
small spacing value will give the appearance of a fluid brush stroke.

Spacing is only evident when making a continuous stroke.

et ¥ 3L 2L h 1’&’

g s
Spacing = 100%

Spacing = 10%

Random Size

You can create variation between the thick and thin of your brush stroke just by
setting the Maximum and Minimum Size values. If you add randomness to the
mix, pressure sensitivity from your drawing tablet will still be applied. Light
pressure will create random values around the minimum, while heavy pressure
will create random values closer to the maximum. The larger the percentage, the
larger the range of random variation.

-

Random Size = 0%
Spacing = 10%

~

Random Size =
50%
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NOTE

Setting the Minimum Size to 100% eliminates the possibility of creating
width variation on your stroke, whether you are applying randomness or
not. Therefore, you would be forcing a uniform line width using the
Maximum Size value.

Random Angle

Sets the range for random rotation around the set Angle value. For example, if
the Angle is set to 45° and the Random Angle set to 10°, the software will
choose values between 40°-50° (plus or minus 5 degrees, equaling a total of 10
degrees).

Random Angle = 0%

~

Random Angle = 60%

Random Spacing

Sets the range for random spacing around the set Spacing value. For example, if
the Spacing is set to 50% and the Random Spacing is set to 10%, then Harmony
will choose values between 45%-55% (plus or minus 5 percent, equaling a total
of 10 percent).

e

Spacing = 10%
Random Spacing = 0%

Spacing = 10%
Random Spacing = 80%

=800 ¢ --

Spacing = 100%
Random Spacing = 0%

Spacing = 100%
Random Spacing = 80%

68



Harmony 20 Paint Reference Guide

Smoothing Tab

The Smoothing tab contains options to configure how Harmony should automatically smooth your brush

strokes as you paint.

Tip Smoothing = Tran

NOTE

The Smoothing tab is only available when working on a vector layer, as bitmap layers do not
support smoothing.

Property Description

Defines the amount of smoothing Harmony should perform on the central line of the
Centerline Smoothing brush stroke. A higher setting will prevent your line from being shaky, but is liable to
reduce drawing precision and turn sharp angles into curves.

Defines the amount of smoothing Harmony should perform on the outer contour of
Contour Smoothing the brush stroke. A higher setting will round sharp corners and reduce the amount of
control points for the resulting vector shape.

Transparency Tab

The Transparency tab allows you to decide if your brush has antialiasing as well as to set its flow and opacity

settings.
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NOTE

The Transparency tab's options are only available on vector layers if the Brush Type option of the
Tip tab is set to Textured Vector Brush. On bitmap layers, those options are always available.

Property Description

Enabled by default. This option causes the contours of the brush strokes to
blend with the surrounding colours, to create an illusion of smoothness
otherwise not possible due to the picture resolution.

If antialiasing is disabled, the brush's texture will only render fully transparent or
fully opaque pixels. Disabling this option can be useful if you need your outlines
o to be very crisp, if you want to make pixel art or if you need your brush strokes to
Antialiasing render in solid colors with no variation, which makes them easier to repaint or

process in third party software.

NOTE

When disabled, all other options in the Transparency tab are disabled.

The Maximum and Minimum Flow parameters let you set the range for the rate at
which paint flows from your brush. The analogy works better with a pen. The
greater the flow, the more ink comes out, hence the more consistent the colour
and texture of the line. If the flow is light, then the colour and texture of the line

may look spotty. This feature works with the pressure sensitivity of a pen tablet.
Maximum and Minimum Flow

o Maximum Flow: Sets the maximum rate at which colour and texture are
applied as you create a fluid stroke.

o Minimum Flow: Sets the minimum rate at which colour and texture are
applied as you create a fluid stroke. It is defined as a percentage of the
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Maximum Flow value. If the Minimum Flow value is set to 100%, then
tablet pressure sensitivity will no longer be applicable. The flow will be
set to the constant rate of the Maximum Flow value.

—————

Maximum Flow = 8§
Opacity = 100%

N

Maximum Flow = 100
Opacity = 100%

Maximum Opacity and
Minimum Opacity

The Maximum and Minimum Opacity parameters are where you set the opacity
range for a brush mark. This works with the pressure sensitivity of a pen tablet.

o Maximum Opacity: Sets the transparency limit of the brush mark when

the pressure is heavy.

o Minimum Opacity: Sets the transparency limit of the brush mark when the
pressure is very light. It is defined as a percentage of the Maximum
Opacity value. If the Minimum Opacity value is set to 100%, then tablet
pressure sensitivity will no longer be applicable. The opacity will be set to
the constant rate of the Maximum Opacity value.

Maximum Flow = 8§
Opacity = 25%

Maximum Flow = 100
Opacity = 25%

Randomness

Th Randomness parameter lets you set the range for the randomness of the flow
and opacity. This works with the pressure sensitivity of a pen tablet.

Randomness Flow

You can create variation in the flow of your brush stroke just by setting the
Maximum and Minimum Flow values. If you add randomness to the mix, pressure
sensitivity from your drawing tablet will still be applied. Light pressure will create
random values around the minimum, while heavy pressure will create random
values closer to the maximum. The larger the percentage, the larger the range of

random variation.
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e

Maximum Flow = 100
Random Flow= 0%

~

Maximum Flow = 100
Random Flow = 100%

-

Maximum Flow = 50
Random Flow = 100%

NOTE

Setting the Minimum Flow value to 100% eliminates the possibility of
creating flow variation on your stroke, whether you are applying
randomness or not. That is, you would be forcing a uniform flow using the
Maximum Flow value.

Random Opacity

You can create variation in the opacity of your brush stroke just by setting the
Maximum and Minimum Opacity values. If you add randomness to the mix,
pressure sensitivity from your drawing tablet will still be applied. Light pressure
will create random values around the minimum, while heavy pressure will create
random values closer to the maximum. The larger the percentage, the larger the
range of random variation.

l

Maximum Opacity = 100
Minimum Opacity = 10%
Random Opacity = 0%

{

Maximum Opacity = 100
Minimum Opacity = 10%
Random Opacity = 10%

_—_e

Maximum Opacity = 100
Minimum Opacity = 10%
Random Opacity = 50%
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NOTE

Setting the Minimum Opacity value to 100% eliminates the possibility of
creating opacity variation on your stroke, whether you are applying
randomness or not. That is, you would be forcing a uniform opacity using
the Maximum Opacity value.

Dual Tip Tab

The Dual Tip tab lets you set the parameters for creating a dual tip brush. The primary bitmap brush tip and the
dual tip always work together. You can set the parameters for the primary tip in the Tip tab and those for the
dual tip in the Dual Tip tab. The Blend mode you select determines how the tips are combined.

By default, the Blend Mode is set to Multiply and the Random Angle to 360°.

Smoothing | Transparency DualTip | M paper Texture

Diamond | Square | Brush01 | Brush02

4

Brush(4 | Brush03 | Brush06 | Brush07 = Tip_01

LA X ks

Tp02 | Tip03 | Tip04 | Tip05 | Tip 06

l
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NOTE

To use a Dual Tip, you must enable option by checking the checkbox inside the Dual Tip tab.
Additionally, if you are working on a vector layer, the Brush Type option of the Tip tab must be set
to Textured Vector Brush.

Description

The checkbox inside the tab allows you to decide whether or not your brush uses a

Enable/Disable dual tip. If this checkbox is unchecked, the options in the Dual Tip tab will be
disabled.

Blend Mode The Blend modes let you decide how the primary tip and the dual tip are combined.
This is the default blend mode. When the two brush tips are combined in this mode,
they essentially cut each other out in overlapping areas, where one or both tips have
an area of 100% transparency. The less opaque the brush tips are, the lighter their
combination.

Circle
. Primary tip
009
Qe
Tip_02
MUltIply N Dual tip

Elend Mode = Multiply

.".‘. e

Blend Mode = Multiply
Random Angle = 360°

Colour Dodge

In this mode, the primary tip cuts out the shape of the dual tip. Where the tip shapes
overlap, within the boundaries of the primary shape, the colour and opacity appear
darker.
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Description

Circle

. Primary tip
~00@
Qe

Tip_02

‘W

Combined

"“....

Elend Mode = Colour Dodge

".“.....

Blend Mode = Colour Dodge
Random Angle = 360°

Combine

This mode treats the two tips as two different and separate brushes that have the
same colour and follow the same path.
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Description

Circle

. Primary tip
009
Qe

Dual tip

‘W

Combined

Elend Mode = Combine
Elend Mode = Combine
Random Angle = 360°

Paper Texture Tab

The Paper Texture tab lets you configure a paper-like texture for your brush. You can also add textures by
importing image files, or import paper textures that were previously exported from Harmony.
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Marker

Texture_5 | Texture_6 | Texture_7

NOTE

To use a Paper Texture, you must enable option by checking the checkbox inside the Paper
Texture tab. Additionally, if you are working on a vector layer, the Brush Type option of the Tip tab
must be set to Textured Vector Brush.

Property

Description

Enable/Disable

The checkbox inside the tab allows you to decide whether or not your brush uses a
paper texture. If this checkbox is unchecked, the options in the Paper Texture tab will
be disabled.

Texture Scale

Increase or decreases the size of the paper texture.

Additive

This option layers the texture on top of itself as you scribble overlapping lines in one
continuous stroke. If this option is turned off, areas of overlapping lines from a single,
continuous stroke will appear the same, in terms of darkness and texture, as non-
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Description

overlapping areas.

Additive enabled Additive disabled

Aligned

This option defines the way separate, overlapping strokes behave. If this option is
enabled, the paper texture's position does not change with each sweep of the brush.
If this option is disabled, each sweep of the brush produces a different texture
position. The texture orientation always stays the same.

Aligned enabled Aligned disabled
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Centerline Editor Tool Properties

The Centerline Editor tool allows you to edit brush strokes by their centreline rather than by their contour. This
makes it easier to tweak the tips, curves and corners of brush strokes. The purpose of this tool is to make it as
easy to edit brush strokes as it is to edit pencil lines with the Contour Editor tool.

How to access the Centerline Editor tool properties

1. Inthe Tools toolbar, select the Centerline Editor 2 tool.

2. Thetool's properties are displayed in the Tool Properties view.

Tool Options

Icon Property Description

Allows you to choose the method to visually select multiple
elements:

. Lasso: Allows you to select multiple elements by
drawing an irregular closed shape around them with your
mouse.

« I\ Marquee: Allows you to select multiple elements by
drawing a rectangle around them. This is faster, as you

Selection Mode only need to drag your mouse from one corner of the

rectangle to its opposite corner, but it may not be as

precise as you want.

SO TIP

’ N

You can press and hold the Alt key to temporarily use
the other selection mode.

When enabled, selecting several control points will make a
X Show Centerline Editor Controls manipulator bounding box appear. You can use this manipulator
to scale and rotate the selection of points.
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Description

Allows you to perform drawing operations on both the Line Art
and Colour Art layers of your drawing simultaneously.

? Apply to Line and Colour Art @ NOTE

If you have Overlay and Underlay Art layers enabled,
they will also be affected when this option is enabled.

Allows you to adjust the amount of control points on the
centreline that is generated from the selected stroke. A lower
. value will create a centreline with less points, which makes it
Centerline Smoothness ] . .
easier to manipulate large lengths of the stroke, and a higher
value will generate a centreline with more points, allowing you to

tweak details.
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Close Gap Tool Properties

The paint tool requires the area you attempt to fill to be closed in order to know exactly what area of your
artwork must be filled. However, it is common for artists to accidentally leave small gaps in their artwork.

The Close Gap tool allows you to quickly close small gaps in a shape by creating an invisible stroke connecting
two extremities of the gap. You can then fill the area using the Paint tool, as this invisible stroke will be taken in

account to determine the outline of the shape tofill.

.‘Q'. TIP
You do not need to use the Close Gap tool with precision. If you draw a crude stroke near the gap
you want to close, the tool will automatically detect the two closest line extremities and will draw an

invisible straight line connecting them. closing the gap between them.

How to access the Close Gap tool properties

1. Inthe Tools toolbar, select the Close Gap ( tool.

The tool's properties are displayed in the Tool Properties view.

Tool Options

Icon Property Description

The Close Gap tool creates an invisible drawing stroke to close the shape. Enabling this
option will merge the stroke into the artwork instead of adding the stroke on top of it.

Auto

i

Flatten @ NOTE
The area you close with the Close Gap tool will be fillable regardless of whether

or not this option is enabled.
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Colour Eyedropper Tool Properties

The Colour Eyedropper tool allows you to pick a colour from your drawing without going to the Colour view.

@ NOTE

The following options will only have an effect when picking colours from a bitmap layer, as they
affect the colour that gets picked. When working on a vector layer, you can only pick colours that
are available in one of the palettes in your scene. Therefore, the colour you pick will always be

exactly the colour that was used to fill the shape or stroke you clicked on.

How to access the Colour Eyedropper tool properties

1. Inthe Tools toolbar, select the Colour Eyedropper # tool.

The tool's properties are displayed in the Tool Properties view.

Tool Properties == | %

Description

By default, the Colour Eyedropper tool picks the colour from the active drawing
layer only. This means that if the colour is semi-transparent, it will still only take the
colour from the active layer, along with its transparency, and ignore the colours

Sample All from layers behind it.

Layers
With this option enabled, the Colour Eyedropper tool will pick the colour as it

appears on the screen instead, allowing you to pick colours that are the result of
several layers composited together.

By default, the Colour Eyedroppertool picks the colour's alpha value as well as its

Do Not Pick . .
@ colour values. When enabled, the colour picked will always have an alpha value of
Transparency 255
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Contour Editor Tool Properties
The Contour Editor lets you reshape vector shapes, brush strokes and lines in your drawings.

Artwork in Harmony is made of vector shapes. Vector shapes are defined by points, the lines joining the points
together (contours) and the curve vectors, represented by Bezier handles, which make the curve of said lines.

Contour
Bezier Bezier
handle handle Paint

The Contour Editor tool allows you to select a contour or point, and change the position of points, add and
remove points from the shape, rotate, lengthen and shorten curve handles to influence the curve of contours
between those points, or drag contours between points to change their curve directly.

How to access the Contour Editor tool properties

1. Inthe Tools toolbar, select the Contour Editor % tool.

The tool's properties are displayed in the Tool Properties view.

Tool Modes

Icon Property Description

Allows you to choose the method to visually select multiple elements:

. Lasso: Allows you to select multiple elements by drawing

. an irregular closed shape around them with your mouse.
Selection Mode

« [xI' Marquee: Allows you to select multiple elements by
drawing a rectangle around them. This is faster, as you only
need to drag your mouse from one corner of the rectangle to
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Description

its opposite corner, but it may not be as precise as you want.

Y- TIP

4 \
You can press and hold the Alt key to temporarily use the
other selection mode.

Allows you to enable or disable snapping for this tool and all other
animation and drawing tools that support snapping, as well as to
select which types of snapping are enabled.

If you double-click or long-click on this button, it will open a pop-up
menu in which you can toggle different snapping modes. You can also
click on this button to toggle it off, which will disable all snapping
modes, and click on it again and toggle it on to re-enable the snapping
modes which were previously enabled.

This tool supports the following snapping modes:

« Snap to Contour: When enabled, moving the control pointin a
contour near another contour will snap that control point
against that contour. This will lock the point and the contour
together, and moving the control point will deform the
contour.

) This option can be especially useful if you need to makes the
@ Snapping edges of two shapes snap together, like so:

==

You can also use this option to make a control point snap
against another control point, allowing you to join lines
together.

M~
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Description

@ NOTE

When a control point is snapped against a contour or
another control point in your drawing, the Contour
Editor will manipulate them together. However, even
if you make a point in one drawing stroke snap
against another drawing stroke, they will remain
separate drawing strokes unless they are flattened
together, and you will still be able to manipulate them

individually with the Select X tool.

« Snap to Alignment Guides: While moving the selection or one
of its control points, it will snap against nearby alignment
guides.

« Snap and Align: Snaps the selected anchor point to any
existing line while displaying temporary rulers as a guide that
you can also snap your anchor point to.

o Snap to Grid: While moving the selection, the mouse cursor
will snap against the intersecting points of the grid.

.‘Q'. TIP

To display the grid, select View > Grid > Show Grid
from the top menu or press Ctrl + .

When enabled, selecting several control points will make a
manipulator bounding box appear. You can use this manipulator to
scale and rotate the selection of points.

g Show Contour Editor
x Controls

If you select and remove part of a pencil line, this option allows you to
. Tip Style choose which kind of line tip the removed segment should leave

behind:

85



Chapter 2: Tools Properties

Description

. . Tip Style: Round: Leaves rounded tips at the extremities of

the deleted line segment.

- mm Tip Style: Flat: Leaves flat tips at the extremities of the

deleted line segment.

Segment to remove

Segment to remove

Allows you to perform drawing operations on both the Line Art and
Colour Art layers of your drawing simultaneously.

? Apply to Line and Colour
Art @ NOTE
If you have Overlay and Underlay Art layers enabled, they
will also be affected when this option is enabled.
Operations

Icon Property

Description

d Smooth Selection

The Smooth operation lets you smooth out selected drawing strokes

and remove extra points.

.‘Q'. TIP

You can also smooth the selection by selecting Selected >

Smooth from the top menu or by pressing Alt + Shift + S.

‘(-z

Split Pencil Line

When drawing with the Polyline tool, your drawing has an even line
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Description

thickness. You can use the Pencil Editor to adjust the thickness point
by point, but if you want to adjust it quicker, you can use the Split
Pencil Line and Point Pencil Lines options to create segments and
apply a pencil stencil to your drawing. Note that if you did not join the
pencil lines on your polyline stroke, the segments between the points
will act as separated segments.

Joined Pelyline Drawing Pencil Stencil Applied on Single Segment

2(-‘

Join Pencil Lines

Split and Joined Pencil Line Segments Pencil Stencil on Multiple Segments
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Cutter Tool Properties

The Cutter tool lets you cut out part of a drawing so that you can transform it, copy it or delete it. It also allows

you to trim overshot lines.

How to access the Cutter tool properties

1. Inthe Tools toolbar, select the Cutter X tool. In the Tools toolbar, click and hold on the Select &
tool to display the menu beneath and select the Cutter 2 tool.

The tool's properties are displayed in the Tool Properties view.

Tool Options

Property Description

Allows you to choose the method to visually select multiple elements:

. Lasso: Allows you to select multiple elements by drawing an
irregular closed shape around them with your mouse.

« [xI Marquee: Allows you to select multiple elements by drawing a

rectangle around them. This is faster, as you only need to drag your
Selection Mode mouse from one corner of the rectangle to its opposite corner, but it
may not be as precise as you want.

.‘Q'. TIP

You can press and hold the Alt key to temporarily use the other

selection mode.

- When enabled, you can drag the selection by clicking anywhere inside its
A Easy Drag bounding box. By default, you must click on the artwork in the selection to be
able to drag it.
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Description

* Use Mouse
Gesture

When this option is enabled along with the Lasso selection type, quickly
drawing a line with the Cutter tool over a line segment in your artwork will
instantly delete it. This can be useful if you want to use the Cutter tool to
quickly clean up your artwork.

= =

It allows you to cutin two modes as follows:

« Single Line Cutting Gesture: It deletes first line segment over which a
straight gesture is drawn with the cutter.

« Multiple Lines Cutting Gesture: It deletes all line segments over which a
straight gesture is drawn with the cutter.

@ NOTE
This option will only work when using the Cutter tool on separate brush
or pencil strokes. Hence, it is important not to flatten your artwork if you
intend to use this option to clean up your drawings. This option has no
effect on bitmap layers as the artwork in bitmap layers is always
flattened.

Use Mouse
( Gesture Breaker
Mode

When using the Lasso selection type, the Use Mouse Gesture Breaker Mode
option lets you draw an invisible stroke on a pencil line to cut itin two
individual objects. Once a pencil line is cut with this option, you will be able to
select the two portions independently with either the Cutter tool, Pencil Editor

tool or Select tool.

t t t

Single pencil line Use Mouse Gesture Breaker mode Two pencil lines
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Description

@ NOTE

This option only works with pencil lines.

Tip Style

When cutting through pencil lines, this option decides what kind of pencil line
tips to put at the extremities of the remaining pencil line segments, where they

were cut.

By default, this is set to Bevel - which will leave the tip of the pencil line cut
at the same angle as your cutter stroke. If you prefer, you can make pencil lines
that you split with the Cutter tool have Flat gg or Round . tips instead.

Antialiasing

When working on bitmap artwork, enabling this will smooth the edges of the
artwork you cut out, so that they do not appear pixelated.

@ NOTE

This option is only available with bitmap layers.

il

Apply to Visible
Drawing Layers

This option allows you to select which layers the tool should affect. It can be
toggled on or off. When toggled on, it has two different modes. You can select
a mode by clicking and holding on the button.
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Description

« Off: When this button is toggled off, the tool only works on the
currently selected layers. If several layers are selected, the tool will work
on all these layers simultaneously.

« [l Apply to Visible Drawing Layers: The tool will work on all the
visible layers in the Camera view.

« ) Apply to Synced Drawing Layers: If the currently selected layer is
synced with another layer, the tool will work on both the current layer

and its synced layer.

@ NOTE

This option only works in the Camera view.

This option allows you to determine which drawings in the current layer the
tool should affect. It can be toggled on or off. When toggled on, it has two
different modes. You can select a mode by clicking and holding on the button.

« Off: When this button is toggled off, the tool only works on the drawing

Apply to All in the current frame.

Frames « [ Apply to All Frames: The tool will work on every exposed drawing in
the selected layer simultaneously.

&

. = Apply to Onion Skin Range: The tool will work on every drawing
displayed in the Onion Skin. Onion Skin must be enabled for this option

to work.

Allows you to perform drawing operations on both the Line Art and Colour Art

layers of your drawing simultaneously.

? Apply to Line and
Colour Art @ NOTE
If you have Overlay and Underlay Art layers enabled, they will also be
affected when this option is enabled.

Operations
Icon Property Description
<]|[> Flip Horizontal Flips the current selection horizontally.
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qIb

Flip Vertical

Flips the current selection vertically.

Rotate 90 Degrees
CW

Rotates the current selection 90 degrees clockwise.

©

Rotate 90 Degrees
CCW

Rotates the current selection 90 degrees counter-clockwise.
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Drawing Pivot Tool Properties

The Drawing Pivot tool lets you set the pivots on your character. You can set the drawing pivots on drawings
and symbols.

Tool Properties

Tool Options

Description

The Set the Pivot for Symbol on All Frames option is
enabled by default. When you set a drawing pivot on
a symbol, all of its cells use the same drawing pivot.
This means you do not have to set a drawing pivot on
all frames. Once you set it, itis done.

If you prefer to set a different drawing pivot for a
series of cells, you can deselect the option and set
your pivots on each cell or cell range.

@ NOTE

If you have already set several different
pivots on your symbol's cells and selected
the Set the Pivot for Symbol on All Frames
option, once you set a new pivot on the
same symbol, all of its pivots will be reset
and will use your new pivot.

Setting the Drawing Pivot for Symbols on

All Frames

Allows you to enable or disable snapping for this tool
and all other animation and drawing tools that
support snapping, as well as to select which types of
snapping are enabled.

@ Snapping If you double-click or long-click on this button, it will
open a pop-up menu in which you can toggle
different snapping modes. You can also click on this
button to toggle it off, which will disable all snapping
modes, and click on it again and toggle it on to re-
enable the snapping modes which were previously
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Description

enabled.
This tool supports the following snapping modes :

« Snap to Contour: When moving the pivot, it
will snap against the nearby points and
contours of your artwork.

« Snap to Alignment Guides: When moving the
pivot, it will snap against nearby alignment
guides.

« Snap and Align: When moving the pivot, it will
align with the edges of elements in the
drawing.

« Snap to Grid: When moving the pivot, it will
snap against the intersecting points of the
grid.

:Q’. TIP
A /s
To display the grid, select View >
Grid > Show Grid from the top
menu or press Ctrl +".

& Reset Pivot

When you click the Reset Pivot option, the drawing
pivot of the selected drawing or symbol is reset to the
centre of the Camera view.

4% Copying Pivot on Parent Symbol

When you import new extra drawings, such as hands
and mouths, you can use the drawing pivot that was
set on your drawings and report them to the symbol's
cells. Use the Copy Pivot to Parent Symbol command
for this.

@ NOTE

When you copy drawing pivots to the parent

symbol, there is no link between the
drawings' pivots and the symbol's pivots. If
you modify the drawing pivot later, it will
not link to the symbol. You would need to
perform the operation again. If you need to
modify the symbol's pivots, you can do it
directly on the symbol's cells.
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Edit Gradient/Texture Tool Properties

The Edit/Gradient Texture tool allows you to move, rotate and scale a gradient or texture fill within the shape it
fills, without modifying the shape itself.

How to access the Edit Gradient/Texture tool properties

1. Inthe Tools toolbar, select the Edit Gradient/Texture [ | tool.

The tool's properties are displayed in the Tool Properties view.

Tool Options

Property Description

This option allows you to select which layers the tool should affect. It can be
toggled on or off. When toggled on, it has two different modes. You can select
a mode by clicking and holding on the button.

« Off: When this button is toggled off, the tool only works on the
currently selected layers. If several layers are selected, the tool will work
on all these layers simultaneously.

Abbl to Visibl « [l Apply to Visible Drawing Layers: The tool will work on all the
i) ppY o visibie visible layers in the Camera view.
Drawing Layers
« ) Apply to Synced Drawing Layers: If the currently selected layer is

synced with another layer, the tool will work on both the current layer

and its synced layer.

@ NOTE

This option only works in the Camera view.
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Ellipse Tool Properties

The Ellipse tool allows you to quickly draw an ellipse or a circle.

How to access the Ellipse tool properties

1. Inthe Tools toolbar, select the Ellipse O tool.

The tool's properties are displayed in the Tool Properties view.

Tool Properties e |3

Pencil 2 Pencil 3 | Fixed Thick...
L ]

10 20 2
Fixed Thick...] Charcoal |Tapered Thi...| Tapered Be...

10 25 12 X |12 X
Tapered En... | Medium Ta...| Pointy Pen... Fat Ends Th...

Pencil Properties

Just like other shape tools, this tool creates pencil lines. Hence, its tool properties are similar to the ones of the

Pencil tool and it can be used with pencil presets.
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Description

Preview Area

The Preview area lets you see a preview of the stroke your drawing tool will make.

. /\/ I

Pencil Properties

The arrow button right of the preview area opens the Pencil Properties dialog.

. /\_/ I

Dialog While the Tool Properties view only gives you access to a few of the pencil properties,
a list of pencil presets and other drawing options, the Pencil Properties dialog gives
you access to all the available options for your pencil's shape and texture. For more
information on the Pencil Properties dialog, see the Pencil Properties Dialog on page
101 section below.

Size Defines the width of the pencil line used to draw the shape.

You can adjust the start, end, and join style of a pencil line.

Shape

« Start: Lets you select the style of the start tip, which is the first tip you drew.
You can choose between Round or Flat style.

« End: Lets you select the style of the end tip, which is the last tip you drew. You
can choose between Round or Flat style.

« Join: Lets you select the joint style. The joints are where the line curves abruptly.
You could also define the Join style as the corner style. You can choose between
Round, Mitre and Bevel style.

Pencil Presets

These options allow you to select, create and manage pencil presets.
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Description

Harmony provides a variety of pencil presets and thickness stencils and
also lets you create and save your own. It is a good idea to create and
save pencils with precise sizes and parameters when you draw for
efficiency and consistency.

A thickness stencil saves the thickness information across the length of
the line. When drawing with a thickness stencil, the pressure sensitivity
Presets list of the tablet is discarded. A thickness stencil can be used while drawing,
or applied afterwards.

You also have the possibility to apply different textures to your lines by
either using the default presets or to import your own.

You can export the pencil presets that you have created and import those
that others have created. This is a good way for you and project
collaborators to keep a consistent look for the project.

* New Brush Preset Creates a new preset based on the current tool properties.

» Delete Brush Preset Deletes the currently selected preset.

Open a menu that contains the following options:

« New Brush Preset: Creates a new preset based on the current tool
properties.

« Delete Brush: Deletes the currently selected preset.

« Rename Brush: Allows you to rename the currently selected
preset.

« Import Brushes: Allows you to import brush presets exported

from Harmony.
E Brush Presets Menu

« ExportBrushes: Allows you to export your brush presets into an
.xml file.

« Small Thumbnail: Displays presets in a grid of small thumbnails
with a preview of their tip.

« Large Thumbnail: Displays presets in a grid of big thumbnails,
with their name and a preview of their tip.

« Stroke View: Displays presets in a list, with their name and a
preview of a stroke done with each preset.

Drawing Options

These options affect the way your shape is added to your artwork.
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Description

& Draw Behind

When enabled, your brush strokes will appear behind the existing artwork.

The orange stroke was drawn
over the black stroke, then put
underneath it.

@ NOTE

Your brush stroke will temporarily appear over your artwork as you
draw it, until you release the mouse cursor or tablet pen.

@ Auto Fill

When enabled, the shape you draw is automatically filled with the selected
colour. By default, drawing a shape only creates its outlines.

_‘Q'_ TIP

By default the pencil line and its fill will be the same colour. To
select different colours for the line and its fill, do the following:

1. Inthe Colour view, click the < Unlock Three Colours
button.

2. Click onthe # Set Current Pencil Colour swatch. Then,
in the colour list, select the desired colour swatch for your
outline.

3. Click onthe ® Set Current Paint Colour swatch. Then, in
the colour list, select the desired colour swatch for the fill.

@ Snapping

Allows you to enable or disable snapping for this tool and all other
animation and drawing tools that support snapping, as well as to select
which types of snapping are enabled.

If you double-click or long-click on this button, it will open a pop-up menu
in which you can toggle different snapping modes. You can also click on
this button to toggle it off, which will disable all snapping modes, and click
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Description
on it again and toggle it on to re-enable the snapping modes which were

previously enabled.
This tool supports the following snapping modes:
« Snap to Contour: When enabled, while you're drawing, the mouse

cursor will snap to the nearby contours of the artwork in your

drawing.
« Snap to Alignment Guides: While drawing, the drawing tool will

snap against nearby alignment guides.
o Snap and Align: When enabled, while you're drawing, the mouse
cursor will automatically align to the rectangular bounding boxes of

other strokes and shapes in your drawing.
« Snap to Grid: While moving the selection, the mouse cursor will

snap against the intersecting points of the grid.

\ ' 4
-Q- TIP
To display the grid, select View > Grid > Show Grid

from the top menu or press Ctrl + .

As you draw in the Line Art layer, the Automatically Create Colour Art

option instantly creates the corresponding strokes in the Colour Art layer

Automatically Create

Colour Art

By default, when drawing on a vector layer, each new stroke is created as a

[

separate drawing object, which can be edited independently from other
parts of the artwork. When enabled, the Auto-Flatten option automatically

=\

merges strokes into existing artwork.

Auto Flatten Mode
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Description

@ NOTE

Using the Select tool, you can use select and remove a segment of
flattened pencil lines. Overlapping pencil lines drawn with the
Auto-Flatten mode are essentially cut into segments by the
overlap and can be treated as individual lines.

The Use Stored Colour Gradient option can be used when painting with a

gradient colour to always position the gradient in the same way it was
] Use Stored Colour . . .
2 . stored, making it consistent across brush strokes. You can store a gradient
Gradient . . . . .
by selecting a zone painted with a gradient with the Select tool, then

clicking on Store Colour Gradient D in the Tool Properties view.

When enabled, the ellipsis tool will always draw an ellipsis of equal width
and height, making it a perfect circle.

Q Draw Circle _\Q'_ TIP

You can also draw a perfect circle by holding the Shift key while
drawing.

Pencil Properties Dialog

The Ellipse tool draws the same type of line as the Pencil tool. Hence, you can configure the Ellipse tool's lines
using the Pencil Properties dialog, which you can open by clicking on the arrow button right of the stroke
display area in the Tool Properties view.

—

Size and Smoothness Tab

The Size and Smoothness tab allows you to select your pencil's size, its smoothing parameters as well as the
shape of its tips and corners.
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Description

Defines the maximum size of the pencil line. If the tool is used with a pressure

. . sensitive pen tablet, the width of the stroke will vary between its maximum size and
Maximum Size . . . .
minimum size depending on the amount of pressure used. If used with a mouse, the

width of the stroke will always be its maximum size.

Defines the minimum size of your stroke as a percentage of the maximum size. If you
Minimum Size do not have pressure sensitivity from a pen table, the minimum size value will be
ignored.

If you check this option, the size of the pencil will be adjusted to the position of the
. camera on the z-axis. This means that if the camera is zoomed in on the scene, the

Proportional to Camera I . . o
pencil will be proportionally smaller so that it appears the same size in the rendered

image. Likewise, if the camera is zoomed out, the pencil will be proportionally bigger.

Defines the amount of smoothing Harmony should perform on the central line of the
. . pencil stroke. A higher setting will prevent your line from being shaky and will reduce
Centerline Smoothing . . o . o
the amount of control points it has, making it easier to tweak, but is liable to reduce

drawing precision and turn sharp angles into curves.

Defines the amount of smoothing Harmony should perform on the outer contour of
the pencil stroke.

A pencil line is defined by its centreline and its variations in thickness, rather than its
apparent shape. When drawing a pencil line with a mouse, its thickness is uniform.
Therefore, its outer contour does not have any control point, except at its extremities,
and no smoothing is required for its contour.

Contour Smoothing

However, when drawing a pencil line with a pressure sensitive tablet, its contour will
have control points and Bezier curves to define the line's variations in thickness, and
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Description

thus smoothing must be performed on its contour. An increased contour smoothing
will reduce the amount of control points on the line's thickness and smoothen its
curves, but may affect the precision of the variations in line thickness.

You can adjust the start, end, and join style of a pencil line.

Shape « Start Lets you select the style of the start tip, which is the first tip you drew.

You can choose between Round or Flat style.

« End: Lets you select the style of the end tip, which is the last tip you drew.
You can choose between Round or Flat style.

« Join: Lets you select the joint style. The joints are where the line curves
abruptly. You could also define the Join style as the corner style. You can
choose between Round, Mitre and Bevel style.

Texture Tab

In the Pencil Properties view, the Texture tab allows you to select a pencil texture from the currently selected
pencil texture palette to use with the Pencil tool. You can also add, remove or rename textures, save the current
pencil texture palette as the default one, or import the pencil texture palette into your scene.

The pencil texture palette used in the Texture tab of the Pencil Properties dialog is the one selected in the
Colour view. You can select a pencil texture palette by selecting it from the pencil texture palette list in the
Colour view—see Colour View on page 235.

103



Chapter 2: Tools Properties

Chalk  Charcoal Rough @ Felt R..
Gradient.. Grain  Bumpy.. Bumpy_...

Grain_ Sq

.| Long_Br...| Long_Br...

f 'll.' '-'| e G T T
Spots Square  Stringy  Stringy_...

BETT R Y ey N

Property Description

This option is available from the menu = button. Sets the currently
selected pencil texture palette as the default pencil texture palette in your

I’:'Ij Use as Default Pencil user preferences. The default pencil texture palette is added to every scene
Texture Palette you create in Harmony. The palette is copied in your preferences, so it will

be added to your new scenes in the exact state it is when you make it the
default pencil texture palette.
Imports the default pencil texture palette as a new pencil texture palette

7 Reload Default Texture . . . .

OH Palette into your scene's palette list, and selects it as the current pencil texture
palette.
Allows you to import an image file into a new pencil texture swatch in the
current pencil texture palette. The pencil texture's effect on your pencil line

+ New Texture will be based on the image's transparency channel, and will follow your

pencil lines on its horizontal axis. This option is also available from the
menu = button.

Deletes a pencil texture swatch from the current pencil texture palette.
Delete Texture ] . . _
This option is also available from the menu = button.

Renames the selected pencil texture swatch in the current pencil texture
Rename Texture . L . =
palette. This option is also available from the menu = button.

Pencil Texture Display Displays the pencil textures in the current pencil texture palette and allows
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Description

you to select one to use with the Pencil tool.

Displays the name of the currently selected pencil texture palette, for
Pencil Texture Palette reference. To select a different pencil texture palette, you must selectitin
the Colour view—see Colour View on page 235.
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Envelope Tool Properties

Selecting the Envelope tool displays its properties and options in the Tool Properties view.

Tool Properties =%

Tool Name Description
Increase the width and height values to add more columns and rows to the
deformation grids.
B -
Width and | |
Height
Sets the selection mode to Lasso, which allows you to select multiple items by drawing
alasso around them.
Lasso SN TIP
-
When this option is enabled, you can press and hold the Alt key to temporarily
use Marquee mode.
Sets the selection mode to Marquee, which allows you to select multiple items by
» Marquee .
drawing a rectangle around them.

106



Harmony 20 Paint Reference Guide

Icon Tool Name Description

]
.‘Q'. TIP
4 \
When this option is enabled, you can press and hold the Alt key to temporarily
use Lasso mode.

Allows you to enable or disable snapping for this tool and all other animation and
drawing tools that support snapping, as well as to select which types of snapping are
enabled.

If you double-click or long-click on this button, it will open a pop-up menu in which
you can toggle different snapping modes. You can also click on this button to toggle it
off, which will disable all snapping modes, and click on it again and toggle it on to re-
enable the snapping modes which were previously enabled.

This tool supports the following snapping modes:

« Snap to Contour: While moving the selection or one of its control points, it will
snap against the nearby points and contours of your artwork, allowing you to
snap parts of your artwork together.

@ Snapping « Snap to Alignment Guides: While moving the selection or one of its control
points, it will snap against nearby alignment guides.

« Snap and Align: When enabled, while moving a selection, the rectangular
bounding box of the selection will snap to the rectangular bounding box of any
other drawing stroke in the drawing, allowing you to align drawing strokes
laterally.

« Snap to Grid: While moving the selection, the mouse cursor will snap against
the intersecting points of the grid.

|
.‘Q'. TIP
To display the grid, select View > Grid > Show Grid from the top
menu or press Ctrl + .

Show
Advanced To display more controls,you can click on the Show Advanced Controls button.

LX)
XX
oo oo

Controls
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Icon

Tool Name

Description

Allows you to perform drawing operations on both the Line Art and Colour Art layers
of your drawing simultaneously.

Apply to
=z i
Line and NOTE
Colour Art
If you have Overlay and Underlay Art layers enabled, they will also be affected
when this option is enabled.
Flip . . .
(”P . Flips the current selection horizontally.
Horizontal
- Flip . . .
= . Flips the current selection vertically.
Vertical
Rotate 90
@ Degrees Rotates the current selection 90 degrees clockwise.
CW
Rotate 90
@ Degrees Rotates the current selection 90 degrees counter-clockwise.
CCW
You can modify the central line smoothness of your line using this option. This
parameter smooths the deformed lines. Increasing the value will result in a smoother
/’ Smooth line with fewer control points. The more you increase the value, the less details and

curves you will get. Use the left and right arrows to increment the value by one full unit.
Use the Up - Down slider to quickly increment the value.
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Eraser Tool Properties

The Eraser tool allows you to erase artwork by drawing eraser strokes over it. When using the Eraser tool with
a tablet, it is pressure sensitive, like with the Brush and Pencil tool.

How to access the Eraser tool properties

1. Inthe Tools toolbar, select the Eraser é/// tool.

The tool's properties are displayed in the Tool Properties view.

Eraser Big Square

500
Soft Eraser
30

Very Soft Eraser
30

Eraser Properties

The way the Eraser tool is configured is almost identical to the way the Brush tool is configured.

Description

The Preview area lets you see a preview of the stroke your drawing tool will make.

Stroke Preview Area

. /\_/ I

Eraser Properties The arrow button right of the display area opens the Eraser Properties dialog, which
Dialog gives you access to all the parameters and options for your eraser. The Tool Properties
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Description

view only gives you access to a few of the eraser properties, a list of eraser presets and
options for the Eraser tool that are not related to the eraser properties. For more
information on the Eraser Properties dialog, see the Eraser Properties Dialog section

below.

. /\_/

Defines the maximum size of the eraser.

Maximum Size If the tool is used with a pressure sensitive pen tablet, the width of the stroke will vary

between its maximum size and minimum size depending on the amount of pressure
used. If used with a mouse, the width of the stroke will always be its maximum size.

Lets you set the opacity for each instance of the eraser tip that gets erased from your
artwork. Contrary to the Opacity parameter, the flow parameter has a cumulative effect.
This means that a lower flow will make your eraser strokes less effective towards its
extremities and more effective in its center. Your stroke's flow will also accumulate if
you draw over it. By default, your eraser's flow varies with the amount of pressure you
put on your tablet pen.

9} NOTE

This option is only displayed in the Tool Properties view when drawing on a

Flow

bitmap layer.

The Opacity parameter are where Lets you set the opacity of your brush strokes.
Contrary to the Flow parameter, the Opacity parameter is non-cumulative. Your whole
brush stroke's opacity will not exceed the Opacity parameter. By default, the Opacity
parameter varies depending on the amount of pressure you put on your tablet pen.

9} NOTE

This option is only displayed in the Tool Properties view when drawing on a

Opacity

bitmap layer.

Eraser Presets

These options allow you to select, create and manage eraser presets.
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Icon Property Description
By default, Harmony has preloaded eraser presets. You can also create
p s list your own eraser presets by configuring your eraser, then saving its
resets lis
properties into a new preset. It is also possible to export and import eraser
presets.
K New Brush Preset Creates a new preset based on the current tool properties.
» Delete Brush Deletes the currently selected preset.
Rename Brush Allows you to rename the currently selected preset.
Import Brushes Allows you to import brush presets exported from Harmony.
Export Brushes Allows you to export your brush presets into an .xml file.
Small Thumbnail Displays presets in a grid of small thumbnails with a preview of their tip.
. Displays presets in a grid of big thumbnails, with their name and a
Large Thumbnail . .
preview of their tip.
. Displays presets in a list, with their name and a preview of a stroke done
Stroke View )
with each preset.

Erasing Options

These options affect the way your eraser strokes are applied to your artwork.

Description

Allows you to perform drawing operations on both the Line Art and Colour
Art layers of your drawing simultaneously.

? Apply to Line and
Colour Art NOTE

If you have Overlay and Underlay Art layers enabled, they will
also be affected when this option is enabled.
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Description

When you erase part of a pencil line, this option determines the shape of
the extremity of the pencil line where you erased:

. . Round: Leaves a round tip at the extremities of the pencil line
you erased.

=>

- pgm Flat Leaves aflat tip at the extremities of the pencil line you
erased. A flat tip is always perpendicular to the angle of the
centreline of the pencil line, so it may not match the angle of your
eraser stroke.

Tip Style
. - Bevel: Leaves a bevel tip at the extremities of the pencil line you
erased. A bevel tip is flat, but its angle matches the angle of your
eraser stroke.
*
Allows you to enable or disable snapping for this tool and all other
animation and drawing tools that support snapping, as well as to select
which types of snapping are enabled.
If you double-click or long-click on this button, it will open a pop-up menu
in which you can toggle different snapping modes. You can also click on
Snapping this button to toggle it off, which will disable all snapping modes, and click

on it again and toggle it on to re-enable the snapping modes which were

previously enabled.
This tool supports the following snapping mode:

o Snap to Alignment Guides: While erasing, the eraser will snap
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Description

against nearby alignment guides.

(\\’ Apply to Synced If the currently selected layer is synced with another layer, the tool will

Drawing Layers work on both the current layer and its synced layer.

Eraser Properties Dialog

Erasers have an extensive set of options and properties that are not displayed in the Tool Properties view, but
rather, in a dialog you can access from it. To open the Eraser Properties dialog, click on the arrow button right of
the stroke display area.

. /\-/ I

The Eraser Properties dialog has five different tabs, minus the Smoothing tab if you are working on a bitmap
layers. Below is detailed information about the options available in each tab:

o Tip Tabon page 113

o Smoothing Tab on page 119

e Transparency Tab on page 120

o Dual Tip Tab on page 123

o Paper Texture Tab on page 127

Tip Tab

The Tip tab allows you to configure the shape, size, hardness and spacing of your eraser tip.
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Diamond | Square

Description

Allows you to select between one of the following eraser types:

« Solid Vector: Simply cuts out the eraser stroke's shape from the vector artwork.
A solid vector eraser always completely erase the artworks leaving hard seams.

« Textured Eraser: Allows to configure the eraser with the same options as with
Eraser Type a textured brush. A textured eraser will decrease the opacity of bitmap textures
in textured brush strokes if it doesn't completely erase it. If it completely erases

a brush stroke, it will cut out the erased part from the vector artwork.

« Textured, Preserve Vector: Like a Textured Eraser, except that it will not cut out
from the vector shapes, even if it fully erases pixels in a textured brush stroke's
texture.
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Description

NOTE

Textured erasers only work as expected on textured brush strokes. Using a
Textured eraser on a solid vector brush stroke or on a pencil line will only cut
the eraser stroke's shape out of it. If you use a Textured, Preserve Vector type
eraser on a solid vector shape or on a pencil line, the eraser will not erase
anything.

NOTE

This option is not available when working on a bitmap layer. With bitmap layers,
erasers are always textured, and textured eraser options are always available.

Eraser Tip Library

Diamond | Square | Brush01 | Brush02

4 b

Brush(4 | Brush05 | Brush06 | Brush07 | Tip_01

LA LK s

Tp02 | Tip03 | Tip04 | Tip05 | Tip 06
S

This is where you select the shape of the eraser tip. By default, it is round. Note that
some tips are designed to have semitransparent areas, even when the maximum eraser
opacity is set to 100%.

To create a custom eraser tip, you must prepare the file ahead of time, either in
Harmony or in a third-party software, such as Adobe Photoshop. Colour is not
supported and transparency is not supported in the traditional sense. Black appears as
100% opaque, white appears as 100% transparent and all the shades of grey in
between appear as varying degrees of semitransparency. A range of file formats are
supported—.jpeg, .png, .tif, .psd, .tga to name a few. Alpha channels are disregarded
on import. It is recommended that your file be between 100 x 100 pixels and 400 x 400
pixels.

You can also import eraser tips that you exported from Harmony, so you can share
them with colleagues.

Minimum and Maximum
Size

The minimum and maximum sizes of your drawing tool produce the thick and thin
effect on your stroke. This works with the pressure sensitivity of a pen tablet.

« Maximum Size: Defines the maximum width of the stroke.

« Minimum Size: Defines the minimum width of the stroke in relation to and as a
percentage of the maximum size.
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(2 o
Setting the Minimum Size value to 100% eliminates the possibility of creating
width variation on your stroke. In other words, you would be forcing a uniform
line width using the Maximum Size value.

If you check this option, the size of the eraser will be adjusted to the position of the
camera on the z-axis. This means that if the camera is zoomed in on the scene, the
eraser will be proportionally smaller so that it appears the same size in the rendered
image. Likewise, if the camera is zoomed out, the eraser will be proportionally bigger.

Proportional to Camera

The Roundness and Angle parameters allow you to change the shape and orientation
of the tip.

« Roundness: The vertical scaling to apply to the tip. Reducing this setting
squashes the tip vertically, allowing you to turn round or square tips into flat

tips.

« Angle: The angle at which to rotate the brush tip, counterclockwise.

Roundness and Angle @ NOTE
The squashing is not relative to the angle—if the tip is rotated, the squashing

will still be done relative to the tip's original orientation.

| - L 2 ’
Roundness: 100% Roundness: 33% Roundness: 100% Roundness: 33%
Angle: 0° Angle: 0° Angle: 457 Angle: 457

If your pen and tablet support tilt sensitivity, this option allows you to set whether your
eraser takes your pen's tilt angle in account, and how much.

When your pen is fully tilted, your eraser tip will be stretched by the percentage you set
Pen Tilt Sensitivity in this parameter, in the angle in which you tilt it. For example, if you set the Pen Tilt
Sensitivity to 50%, and you tilt your pen all the way up or down, your eraser tip will be
stretched vertically by 50%. With the same setting, if you tilt your pen all the way left or
right, your eraser tip will be stretched horizontally by 50%.

116



Harmony 20 Paint Reference Guide

Description

N/

Pen tilted up or down

/\/

Pen tilted left or right

Use Pen Rotation

If enabled, and if your pen and tablet support tip rotation, your eraser tip will rotate
with the angle of your pen tip.

A stroke with a square tip without pen rotation

A stroke with a square tip with pen rotation,
with the pen rotated at 45°

The Hardness and Spacing parameters allow you to change the softness and spacing
of the marks made by the eraser tip. You can preview the hardness and spacing at the
top of the Eraser Properties window, stroke preview area.

The hardness value corresponds to the softness of the eraser tip's edges. The lower the
value, the softer the tip edge. The higher the value, the sharper the tip edge. Be aware
that some eraser tips are not 100% opaque, so they will always appear somewhat soft,

Hardness

even at 100% hardness.

« .
100% Hardness 10% Hardness

Defines the amount of space between each stamp of the eraser. A value of 100% sets

the stamp marks edge to edge, if there is no white space around the shape. The larger

the value, the greater the space between marks. A really large value can make the eraser
Spacing stroke appear as a string of individual marks. Conversely, a small spacing value will give

the appearance of a fluid brush stroke.

Spacing is only evident when making a continuous stroke.
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Description

Spacing = 100%

M—v”

Spacing = 10%

Rand The Randomness parameters let you create a varied bitmap eraser stroke. Refining
andomness
these options can give your stroke a lovely, non-mechanical look.

You can create variation between the thick and thin of your eraser stroke just by setting
the Maximum and Minimum Size values. If you add randomness to the mix, pressure
sensitivity from your drawing tablet will still be applied. Light pressure will create
random values around the minimum, while heavy pressure will create random values
closer to the maximum. The larger the percentage, the larger the range of random
variation.

——

Random Size = 0%
Spacing = 10%

Random Size ~

Random Size =
50%

@ NOTE

Setting the Minimum Size to 100% eliminates the possibility of creating width

variation on your stroke, whether you are applying randomness or not.
Therefore, you would be forcing a uniform line width using the Maximum Size
value.

Sets the range for random rotation around the set Angle value. For example, if the
Random Angle Angle is set to 45° and the Random Angle set to 10°, the software will choose values
between 40°-50° (plus or minus 5 degrees, equaling a total of 10 degrees).
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Description

Random Angle = 0%

‘”’

Random Angle = 60%

Sets the range for random spacing around the set Spacing value. For example, if the
Spacing is set to 50% and the Random Spacing is set to 10%, then Harmony will
choose values between 45%-55% (plus or minus 5 percent, equaling a total of 10
percent).

——

Spacing = 10%
Random Spacing = 0%

Random Spacing ~

Spacing = 10%
Random Spacing = 80%

0000

Spacing = 100%
Random Spacing = 0%

g 1 T

Spacing = 100%
Random Spacing = 80%

Smoothing Tab

The Smoothing tab contains options to configure how Harmony should automatically smooth your eraser
strokes as you paint.
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NOTE

The Smoothing tab is only available when working on a vector layer, as bitmap layers do not

support smoothing.

Property

Description

Centerline Smoothing

Defines the amount of smoothing Harmony should perform on your eraser stroke's
direction, curves and corners. A higher setting will prevent your line from being
shaky, but is liable to reduce drawing precision and turn sharp angles into curves.

Contour Smoothing

Defines the amount of smoothing Harmony should perform on outer contour of the
eraser stroke. A higher setting will round sharp corners and reduce the amount of
control points for the resulting vector shape.

Transparency Tab

The Transparency tab allows you to decide if your eraser has antialiasing as well as to set its flow and opacity

settings.
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NOTE

The Transparency tab's options are only available on vector layers if the Eraser Type option of the
Tip tab is set to Textured Vector or Textured, Preserve Vector.. On bitmap layers, those options

are always available.

Description

Antialiasing

Enabled by default. This option causes the contours of the eraser strokes to
blend with the surrounding colours, to create an illusion of smoothness
otherwise not possible due to the picture resolution.

If antialiasing is disabled, the eraser will either fully erase pixels or leave them
intact.

NOTE

When disabled, all other options in the Transparency tab are disabled.

Maximum and Minimum Flow

The Maximum and Minimum Flow parameters let you set the range for the rate at
which your eraser's effect flows. The greater the flow, the more consistent the
effect is. If the flow is light, then the effect may look spotty. This feature works
with the pressure sensitivity of a pen tablet.

o Maximum Flow: Sets the maximum rate at which colour and texture are
applied as you create a fluid stroke.

o Minimum Flow: Sets the minimum rate at which colour and texture are
applied as you create a fluid stroke. It is defined as a percentage of the
Maximum Flow value. If the Minimum Flow value is set to 100%, then
tablet pressure sensitivity will no longer be applicable. The flow will be
set to the constant rate of the Maximum Flow value.

—

Maximum Flow = 8§
Opacity = 100%

N

Maximum Flow = 100
Opacity = 100%

Maximum Opacity and
Minimum Opacity

The Maximum and Minimum Opacity parameters are where you set the opacity
range for a eraser mark. This works with the pressure sensitivity of a pen tablet.

o Maximum Opacity: Sets the transparency limit of the eraser mark when
the pressure is heavy.
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Description

o Minimum Opacity: Sets the transparency limit of the eraser mark when
the pressure is very light. It is defined as a percentage of the Maximum
Opacity value. If the Minimum Opacity value is set to 100%, then tablet
pressure sensitivity will no longer be applicable. The opacity will be set to
the constant rate of the Maximum Opacity value.

S

Maximum Flow=8
Opacity = 25%

e

Maximum Flow = 100
Opacity = 25%

Randomness

Th Randomness parameter lets you set the range for the randomness of the flow
and opacity. This works with the pressure sensitivity of a pen tablet.

Randomness Flow

You can create variation in the flow of your eraser stroke just by setting the
Maximum and Minimum Flow values. If you add randomness to the mix, pressure
sensitivity from your drawing tablet will still be applied. Light pressure will create
random values around the minimum, while heavy pressure will create random
values closer to the maximum. The larger the percentage, the larger the range of
random variation.

——

Maximum Flow = 100
Random Flow = 0%

~

Maximum Flow = 100
Random Flow = 100%

|

Maximum Flow =50
Random Flow = 100%

@ NOTE

Setting the Minimum Flow value to 100% eliminates the possibility of

creating flow variation on your stroke, whether you are applying
randomness or not. That is, you would be forcing a uniform flow using the
Maximum Flow value.
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Description

You can create variation in the opacity of your eraser stroke just by setting the
Maximum and Minimum Opacity values. If you add randomness to the mix,
pressure sensitivity from your drawing tablet will still be applied. Light pressure
will create random values around the minimum, while heavy pressure will create
random values closer to the maximum. The larger the percentage, the larger the
range of random variation.

l

Maximum Opacity = 100
Minimum Opacity = 10%
Random Opacity = 0%

l

Random Opacity Maximum Opacity = 100
Minimum Opacity = 10%
Random Opacity = 10%

l

Maximum Opacity = 100
Minimum Opacity = 10%
Random Opacity = 50%

@ NOTE

Setting the Minimum Opacity value to 100% eliminates the possibility of
creating opacity variation on your stroke, whether you are applying
randomness or not. That is, you would be forcing a uniform opacity using
the Maximum Opacity value.

Dual Tip Tab

The Dual Tip tab lets you set the parameters for creating a dual tip eraser. The primary bitmap eraser tip and
the dual tip always work together. You can set the parameters for the primary tip in the Tip tab and those for
the dual tip in the Dual Tip tab. The Blend mode you select determines how the tips are combined.

By default, the Blend Mode is set to Multiply and the Random Angle to 360°.
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Diamond | Square | Brush01 | Brush02

4

Brush(4 | Brush03 | Brush06 | Brush07 = Tip_01

LA X ks

Tp02 | Tip03 | Tip04 | Tip05 | Tip 06

NOTE

To use a Dual Tip, you must enable option by checking the checkbox inside the Dual Tip tab.
Additionally, if you are working on a vector layer, the Eraser Type option of the Tip tab must be set
to Textured Vector or Textured, Preserve Vector.

Tool Name Description

The checkbox inside the tab allows you to decide whether or not your eraser uses a

Enable/Disable dual tip. If this checkbox is unchecked, the options in the Dual Tip tab will be
disabled.
Blend Mode The Blend modes let you decide how the primary tip and the dual tip are combined.

This is the default blend mode. When the two eraser tips are combined in this mode,
Multiply they essentially cut each other out in overlapping areas, where one or both tips have
an area of 100% transparency. The less opaque the eraser tips are, the lighter their
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Tool Name

Description

combination.

Circle

. Primary tip
~00@
Qe

Tip_02

I Dual tip
Combined

"Wﬁu w

Elend Mode = Multiply

e T

Blend Mode = Multiply
Random Angle = 360°

Colour Dodge

In this mode, the primary tip cuts out the shape of the dual tip. Where the tip shapes
overlap, within the boundaries of the primary shape, the colour and opacity appear
darker.
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Tool Name Description

Circle

. Primary tip
~00@
Qe

Tip_02

‘W

Combined

"“....

Elend Mode = Colour Dodge

".“.....

Blend Mode = Colour Dodge
Random Angle = 360°

Combi This mode treats the two tips as two different and separate erasers that have the
ombine
same colour and follow the same path.
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Tool Name Description

Circle

. Primary tip
009
Qe

Dual tip

‘W

Combined

Elend Mode = Combine
Elend Mode = Combine
Random Angle = 360°

Paper Texture Tab

The Paper Texture tab lets you configure a paper-like texture for your eraser. You can also add textures by
importing image files, or import paper textures that were previously exported from Harmony.
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NOTE

To use a Paper Texture, you must enable option by checking the checkbox inside the Paper
Texture tab. Additionally, if you are working on a vector layer, the Eraser Type option of the Tip tab
must be set to Textured Vector or Textured, Preserve Vector.

Property

Description

Enable/Disable

The checkbox inside the tab allows you to decide whether or not your eraser uses a
paper texture. If this checkbox is unchecked, the options in the Paper Texture tab will
be disabled.

Texture Scale

Increase or decreases the size of the paper texture.

Additive

This option layers the texture on top of itself as you scribble overlapping lines in one
continuous stroke. If this option is turned off, areas of overlapping lines from a single,
continuous stroke will appear the same, in terms of darkness and texture, as non-

128



Harmony 20 Paint Reference Guide

Description

overlapping areas.

Additive enabled Additive disabled

This option defines the way separate, overlapping strokes behave. If this option is
enabled, the paper texture's position does not change with each sweep of the eraser.
If this option is disabled, each sweep of the eraser produces a different texture
position. The texture orientation always stays the same.

Aligned

Aligned enabled Aligned disabled
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Ink Tool Properties

When you select the Ink tool, its properties and options appear in the Tool Properties view.

Icon Tool Name Tool

Sets the selection mode to Lasso, which allows
you to select multiple items by drawing a lasso
around them.

Lasso TIP

When this option is enabled, you can
press and hold the Alt key to temporarily
use Marquee mode.

Sets the selection mode to Marquee, which allows
you to select multiple items by drawing a rectangle
around them.

N Marquee TIP

When this option is enabled, you can
press and hold the Alt key to temporarily
use Lasso mode.

Highlights all pencil lines (no brush strokes) on the
0 sh Inkable Li selected layer. Pencil line segments that are already

ow Inkable Lines
inked with the selected swatch colour from the

colour palette are also not highlighted.

As you hover and move the cursor across
intersecting pencil lines, the path that you create
will be highlighted. When you click on your mouse
. . or stylus the highlighted segments are inked. With
\ S Be Smart on Connecting Lines . . . - .
this option disabled, all the intersecting segments
that your cursor comes near will be highlighted
and become part of the selection, even if they were

not situated in the direction of the chosen path.
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NOTE

This option only works if the Ink tool is in
Hover mode.

Select Mode

Use this mode instead of the Hover Mode. In the
Hover Mode, any potentially inkable pencil line will
have its central vector line highlighted as the Ink
tool’s cursor hovers over it. Use Ctrl
(Windows/Linux) or &6 (macOS) to toggle between
the two modes.

Select Newly Painted, Repainted,
and Unpainted Contours/Lines

In the Paint tool properties, this option keeps a
selection highlighted around the latest painted
zone after using the Paint, Repaint, Unpaint, or
Paint Unpainted tool.

Raise

As you ink the pencil line, the segment will be
moved on top of the other intersecting strokes.
Disable this option for the line to be sent behind.
Hold down the Alt key to perform the opposite
operation as you ink.

Mitre

As you hover over two perpendicular or nearly
perpendicular segments, a highlighted path with a
corner is created. Clicking on these highlighted
segments inks both segments and makes them
appear as a single stroke with a corner or bend.
Options include: As Is, Round, Miter, and Bevel.

Tip Style

Lets you customize the edge of the Ink tool.
Options include: Round, Flat, and Bevel.
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Line Tool Properties

The Line tool allows you to quickly draw a line segment by dragging the mouse from its starting point to its end

point.

How to access the Line tool properties

1. Inthe Tools toolbar, select the Line / tool.

The tool's properties are displayed in the Tool Properties view.

Tool Properties = |

Pencil 2 Pencil 3 | Fixed Thick...
L ]

10 20 2
Fixed Thick..| Charcoal |Tapered Thi... Tapered Be...

10 25 12 F | 12 £
Tapered En... | Medium Ta...| Pointy Pen... Fat Ends Th...

Pencil Properties

Just like other shape tools, this tool creates pencil lines. Hence, its tool properties are similar to the ones of the
Pencil tool and it can be used with pencil presets.
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Tool Name

Description

Preview Area

The Preview area lets you see a preview of the stroke your drawing tool will make.

. /\/ I

Pencil Properties

The arrow button right of the preview area opens the Pencil Properties dialog.

. /\_/ I

Dialog While the Tool Properties view only gives you access to a few of the pencil properties,
a list of pencil presets and other drawing options, the Pencil Properties dialog gives
you access to all the available options for your pencil's shape and texture. For more
information on the Pencil Properties dialog, see the Pencil Properties Dialog section
below.

Size Defines the width of the pencil line used to draw the line.

You can adjust the start, end, and join style of a pencil line.

Shape

« Start: Lets you select the style of the start tip, which is the first tip you drew.
You can choose between Round or Flat style.

« End: Lets you select the style of the end tip, which is the last tip you drew. You
can choose between Round or Flat style.

« Join: Lets you select the joint style. The joints are where the line curves abruptly.
You could also define the Join style as the corner style. You can choose between
Round, Mitre and Bevel style.

Pencil Presets

These options allow you to select, create and manage pencil presets.
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Description

Harmony provides a variety of pencil presets and thickness stencils and
also lets you create and save your own. It is a good idea to create and
save pencils with precise sizes and parameters when you draw for
efficiency and consistency.

A thickness stencil saves the thickness information across the length of
the line. When drawing with a thickness stencil, the pressure sensitivity
Presets list of the tablet is discarded. A thickness stencil can be used while drawing,
or applied afterwards.

You also have the possibility to apply different textures to your lines by
either using the default presets or to import your own.

You can export the pencil presets that you have created and import those
that others have created. This is a good way for you and project
collaborators to keep a consistent look for the project.

* New Brush Preset Creates a new preset based on the current tool properties.

» Delete Brush Preset Deletes the currently selected preset.

Open a menu that contains the following options:

« New Brush Preset: Creates a new preset based on the current tool
properties.

« Delete Brush: Deletes the currently selected preset.

« Rename Brush: Allows you to rename the currently selected
preset.

« Import Brushes: Allows you to import brush presets exported

from Harmony.
E Brush Presets Menu

« ExportBrushes: Allows you to export your brush presets into an
.xml file.

« Small Thumbnail: Displays presets in a grid of small thumbnails
with a preview of their tip.

« Large Thumbnail: Displays presets in a grid of big thumbnails,
with their name and a preview of their tip.

« Stroke View: Displays presets in a list, with their name and a
preview of a stroke done with each preset.

Drawing Options

These options affect the way your drawing strokes are added to your artwork.
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Icon Tool Name Description

When enabled, your brush strokes will appear behind the existing artwork.

The orange stroke was drawn
over the black stroke, then put
underneath it.

& Draw Behind

@ NOTE

Your brush stroke will temporarily appear over your artwork as you draw it,
until you release the mouse cursor or tablet pen.

Allows you to enable or disable snapping for this tool and all other animation and
drawing tools that support snapping, as well as to select which types of snapping
are enabled.

If you double-click or long-click on this button, it will open a pop-up menu in which
you can toggle different snapping modes. You can also click on this button to
toggle it off, which will disable all snapping modes, and click on it again and toggle
it on to re-enable the snapping modes which were previously enabled.

This tool supports the following snapping modes:

« Snap to Contour: When enabled, while you're drawing, the mouse cursor
will automatically snap to the nearby contours of existing artwork, allowing
you to draw shapes that connect with other parts of your drawing.

@ Snapping >

@ NOTE

If you draw a line with the Line tool and make its tip snap to a

contour or another control point in your artwork, they will be locked

together. You can then manipulate both simultaneously using the
\} Contour Editor tool. You can also separate two drawing strokes

that have been snapped together by selecting one of them with the
X Select tool and moving it away.

« Snap to Alignment Guides: While drawing, the drawing tool will snap
against nearby alignment guides.
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Description

Icon

Tool Name
« Snap and Align: When enabled, while you're drawing, the mouse cursor will
automatically align with the edges of strokes and shapes in your artwork,

allowing you to draw shapes that align with parts of your drawing.

« When enabled, while you're drawing, the mouse cursor will snap against

the intersecting points of the grid.

To display the grid, select View > Grid > Show Grid from the top

.‘Q'. TIP

menu or press Ctrl + .

As you draw in the Line Art layer, the Automatically Create Colour Art option

instantly creates the corresponding strokes in the Colour Art layer.

Automatically
Create Colour

Art

&

By default, when drawing on a vector layer, each new stroke is created as a separate
drawing object, which can be edited independently from other parts of the artwork.
When enabled, the Auto-Flatten option automatically merges strokes into existing

artwork.

Auto-Flatten
Mode

N
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Icon Tool Name Description

@ NOTE

Using the Select tool, you can use select and remove a segment of flattened
pencil lines. Overlapping pencil lines drawn with the Auto-Flatten mode are

essentially cut into segments by the overlap and can be treated as individual
lines.

When enabled, small gaps between the pencil lines you draw will be closed by an
invisible stroke to make sure your shapes are closed and that they can be filled with
the Paint tool.

When drawing contours with pencil lines, the centreline is used to determine
whether or not the contour is closed, but the visible tips of the pencil line will
extend a bit beyond the tips of its centreline, making it possible to have shapes that
appear closed, but are not really. This can prevent the shape from being filled with
the Paint tool. Enabling this option when drawing with the Pencil or Line tool will

N Auto-Close prevent you from leaving invisible gaps in your contours.
Gap
Aute Close Gap off Aute Close Gap en

The Line Building mode is very useful when drawing long lines and curves in small
increments with pencil lines or the Line tool. As the pencil lines are central vector
lines, it may be difficult to align the line tips perfectly to create a uniform stroke and
close all gaps.

In this mode, you can draw lines in small increments and the tips are merge into one
single stroke.

N s L Buiilding mode

s Normal mode

_CE Line Building
Mode
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Tool Name

Description

@ NOTE

This mode only works with pencil lines or the line tool.

The Use Stored Colour Gradient option can be used when painting with a gradient

Use Stored colour to always position the gradient in the same way it was stored, making it
Colour consistent across brush strokes. You can store a gradient by selecting a zone
Gradient painted with a gradient with the Select tool, then clicking on Store Colour Gradient
[ in the Tool Properties view.
Draws a straight line.
In this mode, you can draw curved lines with the following method:
1. Draw theline by clicking and dragging from the start point to the end point
of the line, but don’t release the mouse button or pen yet.
s
Straight Line
Mode 2. While holding the mouse button or pen down, press and hold the Ctrl
(Windows/Linux) or 3£ (macOS) and move the mouse or pen to define the
line’s curve.
I\\
3. Oncetheline’s curve looks right, release the mouse button or pen.
This mode allows you to draws a simple curved (quadratic Bezier) line in two clicks:
1. Draw theline by clicking and dragging from the start point to the end point
of the line.
Curve Line
Mode

\

2. Move the mouse or pen to define the curve of the line and click.
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Icon Tool Name Description

—

Draws an S-shaped (cubic Bezier) line. This mode allows you to draw lines with
finely tuned or even S-shaped curves with three clicks:

1. Draw the line by clicking and dragging from the start point to the end point
of the line.

//7

2. Move the mouse or pen to define the Bezier position of the beginning of the
line and click.

,l"l
f\/ < Curve Line r—\
Mode

3. Move the mouse or pen to define the Bezier position of the end of the line
and click.

Pencil Properties Dialog

Since the Line tool draws pencil lines, you can use the Pencil Properties dialog to customize the type of lines it
draws. To open the Pencil Properties dialog, click on the arrow button right of the stroke display area.
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Size and Smoothness Tab

The Size and Smoothness tab allows you to select your pencil's size, its smoothing parameters as well as the
shape of its tips and corners.

Property Description

Defines the maximum size of the pencil line. If the tool is used with a pressure

. . sensitive pen tablet, the width of the stroke will vary between its maximum size and
Maximum Size . . . ;
minimum size depending on the amount of pressure used. If used with a mouse, the

width of the stroke will always be its maximum size.

Defines the minimum size of your stroke as a percentage of the maximum size. If you
Minimum Size do not have pressure sensitivity from a pen table, the minimum size value will be
ignored.

If you check this option, the size of the pencil will be adjusted to the position of the
. camera on the z-axis. This means that if the camera is zoomed in on the scene, the

Proportional to Camera I . . .
pencil will be proportionally smaller so that it appears the same size in the rendered

image. Likewise, if the camera is zoomed out, the pencil will be proportionally bigger.

Defines the amount of smoothing Harmony should perform on the central line of the
. . pencil stroke. A higher setting will prevent your line from being shaky and will reduce
Centerline Smoothing . . L . -
the amount of control points it has, making it easier to tweak, but is liable to reduce

drawing precision and turn sharp angles into curves.

Contour Smoothing Defines the amount of smoothing Harmony should perform on the outer contour of
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Description

the pencil stroke.

A pencil line is defined by its centreline and its variations in thickness, rather than its
apparent shape. When drawing a pencil line with a mouse, its thickness is uniform.
Therefore, its outer contour does not have any control point, except at its extremities,
and no smoothing is required for its contour.

However, when drawing a pencil line with a pressure sensitive tablet, its contour will
have control points and Bezier curves to define the line's variations in thickness, and
thus smoothing must be performed on its contour. An increased contour smoothing
will reduce the amount of control points on the line's thickness and smoothen its
curves, but may affect the precision of the variations in line thickness.

You can adjust the start, end, and join style of a pencil line.

Shape « Start: Lets you select the style of the start tip, which is the first tip you drew.

You can choose between Round or Flat style.

« End: Lets you select the style of the end tip, which is the last tip you drew.
You can choose between Round or Flat style.

« Join: Lets you select the joint style. The joints are where the line curves
abruptly. You could also define the Join style as the corner style. You can
choose between Round, Mitre and Bevel style.

Texture Tab

In the Pencil Properties view, the Texture tab allows you to select a pencil texture from the currently selected
pencil texture palette to use with the Pencil tool. You can also add, remove or rename textures, save the current
pencil texture palette as the default one, or import the pencil texture palette into your scene.

The pencil texture palette used in the Texture tab of the Pencil Properties dialog is the one selected in the
Colour view. You can select a pencil texture palette by selecting it from the pencil texture palette list in the
Colour view—see Colour View on page 235.
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Chalk  Charcoal Rough @ Felt R..
Gradient.. Grain  Bumpy.. Bumpy_...

Grain_ Sq

.| Long_Br...| Long_Br...

f 'll.' '-'| e G T T
Spots Square  Stringy  Stringy_...

BETT R Y ey N

Property Description

This option is available from the menu = button. Sets the currently
selected pencil texture palette as the default pencil texture palette in your

I’:'Ij Use as Default Pencil user preferences. The default pencil texture palette is added to every scene
Texture Palette you create in Harmony. The palette is copied in your preferences, so it will

be added to your new scenes in the exact state it is when you make it the
default pencil texture palette.
Imports the default pencil texture palette as a new pencil texture palette

7 Reload Default Texture . . . .

OH Palette into your scene's palette list, and selects it as the current pencil texture
palette.
Allows you to import an image file into a new pencil texture swatch in the
current pencil texture palette. The pencil texture's effect on your pencil line

+ New Texture will be based on the image's transparency channel, and will follow your

pencil lines on its horizontal axis. This option is also available from the
menu = button.

Deletes a pencil texture swatch from the current pencil texture palette.
Delete Texture ] . . _
This option is also available from the menu = button.

Renames the selected pencil texture swatch in the current pencil texture
Rename Texture . L . =
palette. This option is also available from the menu = button.

Pencil Texture Display Displays the pencil textures in the current pencil texture palette and allows
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Description

you to select one to use with the Pencil tool.

Displays the name of the currently selected pencil texture palette, for
Pencil Texture Palette reference. To select a different pencil texture palette, you must selectitin
the Colour view—see Colour View on page 235.
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Paint Tool Properties

The Paint tool allows you to fill closed areas of your drawing with the selected colour.

How to access the Paint tool properties

1. Inthe Tools toolbar, select the Paint ® , Paint Unpainted ®  Repaint ® or Unpaint ® tool.

The tool's properties are displayed in the Tool Properties view.

Paint Tool Options

Description

Allows you to choose the method to visually select multiple elements:

. Lasso: Allows you to select multiple elements by drawing an irregular
closed shape around them with your mouse.

« [IxI' Marquee: Allows you to select multiple elements by drawing a

rectangle around them. This is faster, as you only need to drag your mouse
Selection Mode from one corner of the rectangle to its opposite corner, but it may not be
as precise as you want.

0N TIP

’ N
You can press and hold the Alt key to temporarily use the other selection

mode.
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Description

The Paint tool has four different modes:

«  ® paint: Paints or repaints selected zones, whether or not they are
already filled.

o ®paint Unpainted: Only paints empty zones, and does not repaint zones
= Paint Mode that are already filled with colour.

. ® Repaint: Only paints zones that are already filled with colour, and does
not fill empty zones.

. ® Unpaint: Removes colour from the selected zone, replacing it with
transparency.

The Paint and Remove Texture option is used when you vectorized images as

greyscale texture style. An image vectorized as texture is a mix of bitmap filling
encapsulated in a vector-based frame. Painting a textured zones with the Paint
tool will change the tint of the textured lines. Painting the textured zones using
the Paint and Remove Texture option transforms the bitmap filling into a 100%

Paint and vector based zone and fills it with a solid colour.
L Remove
Textures
This option allows you to select which layers the tool should affect. It can be
toggled on or off. When toggled on, it has two different modes. You can select a
mode by clicking and holding on the button.

« Off: When this button is toggled off, the tool only works on the currently
selected layers. If several layers are selected, the tool will work on all these
layers simultaneously.

Aooly to Visibl « [l Apply to Visible Drawing Layers: The tool will work on all the visible
Et{‘]l' pply o Visible layers in the Camera view.

Drawing Layers

« ! Apply to Synced Drawing Layers: If the currently selected layer is
synced with another layer, the tool will work on both the current layer and
its synced layer.

@ NOTE

This option only works in the Camera view.
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Description

This option allows you to determine which drawings in the current layer the tool
should affect. It can be toggled on or off. When toggled on, it has two different
modes. You can select a mode by clicking and holding on the button.

« Off: When this button is toggled off, the tool only works on the drawing
in the current frame.

. @ Apply to All Frames: The tool will work on every exposed drawing in
the selected layer simultaneously.

. = Apply to Onion Skin Range: The tool will work on every drawing
displayed in the Onion Skin. Onion Skin must be enabled for this option to

Apply to Al work.

Frames

&l

You can quickly paint several
drawings in the same layer
simultaneously, provided that they
have overlapping colour zones.

The Respect Protected Colour option is enabled by default. In your Colour view,
you can protect some colour swatches to avoid repainting or unpainting the

Respect zones linked to that swatch.
B‘ Protected

Colour If you disable this option the Paint tool will not follow the protect colour rule and

will repaint or unpaint the protected colours on your drawings until you enable
the option again.

When you paint a zone with a gradient or textured colour swatch, the gradient or

texture’s position is set relative to the size of the zone you are painting. If you
nE Use Stored . . . . .
2 Col Gradient want the Paint tool to use a particular size and position, you must first store your
olour Gradien
desired position and size using the Select tool and then enable the Use Stored

Colour Gradient option in the Paint tool properties.
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Description

In the Paint tool properties, this option keeps a selection highlighted around the
latest painted zone after using the Paint, Repaint, Unpaint, or Paint Unpainted

tool.

Select Newly
Painted,

fk‘) Repainted, and
Unpainted
Contours/Lines

By default, if you attempt to fill a shape that has a small gap in its contour, the
Paint tool will not be able to fill the shape. This option allows you to make the
Paint tool automatically add a stroke to close the shape when it detects a small

gap between two strokes in the shape.

The Close Gap setting can be set to a value between 0 and 10. This determines
the maximum size of a gap to close, in pixels. You can also use one of the

following presets:

U Close Gap « (UNo Close Gap: Sets the Close Gap setting to 0, disabling the feature.

« OClose Small Gap: Sets the Close Gap setting to 2, making the Paint tool
close gaps that are barely visible.

o (O Close Medium Gap: Sets the Close Gap setting to 4, making the Paint
tool close gaps that are somewhat visible.

» (DClose Large Gap: Sets the Close Gap setting to 8, making the Paint
tool close gaps that are easy to notice.
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Bitmap Options

Since bitmap drawings are made of pixels instead of shapes, and that the outlines of shapes in bitmap
drawings are often feathered, it can be complicated to figure out exactly the area the Paint tool must fill when
trying tofill a zone in a bitmap drawing. For example, if the Paint tool only replaces pixels with the exact same
colour as the one you click on with the selected colour, it will leave a small gap near the outlines of the shape.

A square filled with all the Source settings set
to 0. The fill stops just as soon as it reaches a
gray pixel.

A square filled with the proper source settings.

The fill reaches up to the centreline of the
square, but is applied behind it to preserve the
outline's thickness and antialiasing.

I:K-

The following settings determine how the Paint tool figures out the area it must fill. When any of these settings
are increased, the Paint tool's tolerance for colour or alpha differences increases and it will a bigger area that it
otherwise would.

Property Description

Allows you to select which art layer to use in order to determine the
fillable zone. By default, this is set to Current Art =, which means the
layer you are filling will be used to determine the fillable zone. However,
if you want to keep your colour art on the Colour Art layer and the line art
on the Line Art layer, you can set the Source to Line Art vL, and then use
the Paint tool on the Colour Art layer. The Paint tool will use the artwork
in the Line Art layer to determine the area to fill with colour, but will still

add this colour to the Colour Art layer.
\ 4 Source 4

This property has the following options:

o ©-Current Art: Bases the zone to fill on the current art layer.

« %= Line Art: Bases the zone to fill on the Line Art layer,
regardless of which layer you are painting on.

. VCCoIour Art: Bases the zone to fill on the Colour Art layer,
regardless of which layer you are painting on.

The alpha threshold that separates opaque and transparent zones. When
filling a "transparent" zone, the paint tool will apply the colour under
semi-transparent pixels, making them opaque. Then filling an "opaque"
- Alpha zone, the paint tool will replace the colour of semi-transparent pixels
without affecting their transparency.

If you want to repaint lineart or shapes that have no outlines, you can do
so by decreasing this setting completely. This will make it fill any pixel
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Description

that isn't 100% transparent, so it will paint your outlines completely.
However, if you're using this method to repaint outlines, they must not
be filled yet for this method to work.

If you want to paint transparent zones that have dirt or semi-transparent
spots, you can increase this setting to make the Paint tool paint behind
them instead of around them.

@ NOTE

Raising this setting too high may cause the paint tool to ignore
outlines that are not 100% opaque, which can cause it to think
the shape is not closed. Hence, it might fail to find a zone to fill
and not do anything.

-- Colour Tolerance

The amount of tolerance the paint tool has for changes in colour when
filling an area. Raising this setting will allow the paint tool to fill over
areas that have some variations in colour, but may cause it to fill beyond
the areas you meant to paint.

-- Maximum Overlap

The maximum amount of pixels beyond the fillable zone that the Paint
tool can fill.

When this setting is set to any value above zero, the paint tool will fill
the zone until it finds a pixel that is a different colour, value or
transparency as the one you clicked on. Then, it will start filling pixels
beyond that point, up until it filled the amount of pixels in the Maximum
Overlap setting.

If it lands outside of a fillable zone before it reached the maximum
overlap, it will stop filling at that point. However, if it lands into another
fillable zone before reaching its maximum overlap, it will fill that zone as
well. Therefore, if you're filling shapes inside other shapes, you have to
set this setting to the approximate width of your outlines. Setting it
higher will make the colour spill beyond the zone you clicked on and fill
the zone outside of it, and setting it lower is liable to leave a small gap
between the fill and the outlines.
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Description

@) NOTE

When you fill a zone with overlap, Harmony tries to detect and
preserve the outlines of your shape. This is easy to do when
filling a transparent shape, or when repainting a shape made of
solid outlines and a solid fill. However, if you are trying to
repaint an already painted zone, it may fail to detect your
outlines and may repaint over them if the colour of your outlines
or inside the shape isn't consistent. Therefore, it is highly
recommended to avoid repainting painted zones as much as
possible when working with bitmap layers.

When enabled, the outlines of the fill will be smoothed so that they do
not look pixelated.

r Antialiasing @ NOTE

The effect of this setting will not be visible if you fill all the way
to the outlines, as the Paint tool will preserve the antialiasing of
existing outlines when filling up to them.
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Pencil Tool Properties

The Pencil tool allows you to draw simple contour lines that are defined by their centerline and their thickness.

When you select the Pencil tool, the Tool Properties view displays the different Pencil modes that control how

the pencil line is drawn.

How to access the Pencil tool properties

1. Inthe Tools toolbar, select the Pencil £ tool.

The tool's properties are displayed in the Tool Properties view.

Pencil Properties

The following properties affect the pencil's size, smoothing, shape and other properties for the drawing style of

your pencil. Those properties can be saved into pencil presets for later use.

Description

The Preview area lets you see a preview of the stroke your drawing tool will make.

Preview Area —~— I
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Description

Pencil Properties
Dialog

The arrow button right of the preview area opens the Pencil Properties dialog.

. /\_/ I

While the Tool Properties view only gives you access to a few of the pencil properties,
a list of pencil presets and other drawing options, the Pencil Properties dialog gives
you access to all the available options for your pencil's shape and texture. For more
information on the Pencil Properties dialog, see the Pencil Properties Dialog section

below.

Maximum Size

Defines the maximum width of the pencil line.

If the tool is used with a pressure sensitive pen tablet, the width of the stroke will vary
between its maximum size and minimum size depending on the amount of pressure
used. If used with a mouse, the width of the stroke will always be its maximum size.

Centerline Smoothing

Defines the number of control points added to the centre line. The fewer the control
points the smoother (but less faithful) the line.

Shape

You can adjust the start, end, and join style of a pencil line.

« Start Lets you select the style of the start tip, which is the first tip you drew.
You can choose between Round or Flat style.

« End: Lets you select the style of the end tip, which is the last tip you drew. You
can choose between Round or Flat style.

« Join: Lets you select the joint style. The joints are where the line curves abruptly.
You could also define the Join style as the corner style. You can choose between
Round, Mitre and Bevel style.

Pencil Presets

These options allow you to select, create and manage pencil presets.
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Description

Presets list

Harmony provides a variety of pencil presets and thickness stencils and
also lets you create and save your own. It is a good idea to create and
save pencils with precise sizes and parameters when you draw for
efficiency and consistency.

A thickness stencil saves the thickness information across the length of
the line. When drawing with a thickness stencil, the pressure sensitivity
of the tablet is discarded. A thickness stencil can be used while drawing,
or applied afterwards.

You also have the possibility to apply different textures to your lines by
either using the default presets or to import your own.

You can export the pencil presets that you have created and import those
that others have created. This is a good way for you and project
collaborators to keep a consistent look for the project.

* New Brush Preset

Creates a new preset based on the current tool properties.

by Delete Brush Preset

Deletes the currently selected preset.

E Brush Presets Menu

Open a menu that contains the following options:

« New Brush Preset: Creates a new preset based on the current tool
properties.

« Delete Brush: Deletes the currently selected preset.

« Rename Brush: Allows you to rename the currently selected
preset.

« Import Brushes: Allows you to import brush presets exported
from Harmony.

« ExportBrushes: Allows you to export your brush presets into an
.xml file.

« Small Thumbnail: Displays presets in a grid of small thumbnails
with a preview of their tip.

« Large Thumbnail: Displays presets in a grid of big thumbnails,
with their name and a preview of their tip.

« Stroke View: Displays presets in a list, with their name and a
preview of a stroke done with each preset.

Drawing Options

These options affect the way your drawing strokes are added to your artwork.
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Description

When enabled, your brush strokes will appear behind the existing artwork.

The orange stroke was drawn
over the black stroke, then put
underneath it.

& Draw Behind

@ NOTE

Your brush stroke will temporarily appear over your artwork as you
draw it, until you release the mouse cursor or tablet pen.

When enabled, drawing a closed shape will automatically fill it with the
currently selected Paint colour.

‘
Y- TIP
[ ) Auto Fill A

By default the pencil line and its fill will be the same colour. To

select different colours for the line and its fill, do the following:

1. Inthe Colour view, click the < Unlock Three Colours
button.

2. Click onthe # Set Current Pencil Colour swatch. Then,
in the colour list, select the desired colour swatch for your
outline.

3. Click on the ™ Set Current Paint Colour swatch. Then, in
the colour list, select the desired colour swatch for the fill.

When enabled, drawing a closed shape will automatically remove the
outstanding lines.

é Trim Extra Lines
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Align Handles After

76 Trim

Description

curve rather than a hard corner.

As you draw in the Line Art layer, the Automatically Create Colour Art

When the Trim Extra Lines option is enabled, enable this option to make
the point where the beginning and end of the stroke meet into a smooth

Colour Art

&

Automatically Create

option instantly creates the corresponding strokes in the Colour Art layer

By default, when drawing on a vector layer, each new stroke is created as a

i

Auto Flatten

separate drawing object, which can be edited independently from other

parts of the artwork. When enabled, the Auto-Flatten option automatically

merges strokes into existing artwork.

(2 Mo
Using the Select tool, you can select and remove a segment of
flattened pencil lines. Overlapping pencil lines drawn with the

Auto-Flatten mode are essentially cut into segments by the

overlap and can be treated as individual lines.

When enabled, small gaps between the pencil lines you draw will be

s\

Auto-Close Gap

closed by an invisible stroke to make sure your shapes are closed and that

they can be filled with the Paint tool.
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Description

When drawing contours with pencil lines, the centreline is used to
determine whether or not the contour is closed, but the visible tips of the
pencil line will extend a bit beyond the tips of its centreline, making it
possible to have shapes that appear closed, but are not really. This can
prevent the shape from being filled with the Paint tool. Enabling this
option when drawing with the Pencil or Line tool will prevent you from
leaving invisible gaps in your contours.

Auto Close Gap off Auto Close Gap on

Allows you to enable or disable snapping for this tool and all other
animation and drawing tools that support snapping, as well as to select
which types of snapping are enabled.

If you double-click or long-click on this button, it will open a pop-up menu
in which you can toggle different snapping modes. You can also click on
@ Snapping this button to toggle it off, which will disable all snapping modes, and click
on it again and toggle it on to re-enable the snapping modes which were
previously enabled.

This tool supports the following snapping mode:

« Snap to Alignment Guides: While drawing, the drawing tool will
snap against nearby alignment guides.

The Line Building mode is very useful when drawing long lines and curves
in small increments with pencil lines or the Line tool. As the pencil lines are
; central vector lines, it may be difficult to align the line tips perfectly to

Line Building Mode create a uniform stroke and close all gaps.

In this mode, you can draw lines in small increments and the tips are merge
into one single stroke.
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Description

NOTE

This mode only works with pencil lines or the line tool.

Auto Adjust Thickness

The Auto Adjust Thickness tool is useful when you want to render a
portion of a line thicker. When tracing a drawing on paper, you will often
go back to a section of a curve to make it thicker to add dynamism to the
line. Using the Auto Adjust Thickness tool, you can draw highlight strokes
over the section to make thicker. Once you release the pen or mouse, the
line becomes thicker following the shape and curve of the original stroke.
This way is much faster and smoother than using the Pencil Editor tool.
You do not have to add extra points and adjust the position and Bezier
handles.

The default overlay colour is light yellow. If this colour is difficult to see
because of the background or drawing colour, you can adjust the colour.

Line Pushing Mode

The Line Pushing Mode option lets you draw highlight strokes over
existing pencil lines. You can reshape the curves. Depending how you
draw the pushing stroke over your line, the highlighted section will be
reshaped in one direction or the other.

The default overlay colour is light yellow. If this colour is difficult to see
because of the background or drawing colour, you can adjust the colour.

Colour

You can change the colour of the temporary strokes that appear in the
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Description

drawing space when using the Line Pushing Mode or the Auto Adjust
Thickness option by clicking on the Colour swatch and selecting a new
colour in the Colour Picker dialog.

Pencil Properties Dialog

Pencils have extra parameters which are not accessible from the Tool Properties view. To open the Pencil
Properties dialog, click on the arrow button right of the stroke display area.

— 1

Size and Smoothness Tab

The Size and Smoothness tab allows you to select your pencil's size, its smoothing parameters as well as the

shape of its tips and corners.

Description

Defines the maximum size of the pencil line. If the tool is used with a pressure

. . sensitive pen tablet, the width of the stroke will vary between its maximum size and
Maximum Size . . . ;
minimum size depending on the amount of pressure used. If used with a mouse, the

width of the stroke will always be its maximum size.
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Description

Minimum Size

Defines the minimum size of your stroke as a percentage of the maximum size. If you
do not have pressure sensitivity from a pen table, the minimum size value will be
ignored.

Proportional to Camera

If you check this option, the size of the pencil will be adjusted to the position of the
camera on the z-axis. This means that if the camera is zoomed in on the scene, the
pencil will be proportionally smaller so that it appears the same size in the rendered
image. Likewise, if the camera is zoomed out, the pencil will be proportionally bigger.

Centerline Smoothing

Defines the amount of smoothing Harmony should perform on the central line of the
pencil stroke. A higher setting will prevent your line from being shaky and will reduce
the amount of control points it has, making it easier to tweak, but is liable to reduce
drawing precision and turn sharp angles into curves.

Contour Smoothing

Defines the amount of smoothing Harmony should perform on the outer contour of
the pencil stroke.

A pencil line is defined by its centreline and its variations in thickness, rather than its
apparent shape. When drawing a pencil line with a mouse, its thickness is uniform.
Therefore, its outer contour does not have any control point, except at its extremities,
and no smoothing is required for its contour.

However, when drawing a pencil line with a pressure sensitive tablet, its contour will
have control points and Bezier curves to define the line's variations in thickness, and
thus smoothing must be performed on its contour. An increased contour smoothing
will reduce the amount of control points on the line's thickness and smoothen its
curves, but may affect the precision of the variations in line thickness.

Shape

You can adjust the start, end, and join style of a pencil line.

Shape

A

Mitre

Bevel

o Start Lets you select the style of the start tip, which is the first tip you drew.
You can choose between Round or Flat style.

o End: Lets you select the style of the end tip, which is the last tip you drew.
You can choose between Round or Flat style.

« Join: Lets you select the joint style. The joints are where the line curves
abruptly. You could also define the Join style as the corner style. You can
choose between Round, Mitre and Bevel style.
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Texture Tab

In the Pencil Properties view, the Texture tab allows you to select a pencil texture from the currently selected
pencil texture palette to use with the Pencil tool. You can also add, remove or rename textures, save the current
pencil texture palette as the default one, or import the pencil texture palette into your scene.

The pencil texture palette used in the Texture tab of the Pencil Properties dialog is the one selected in the
Colour view. You can select a pencil texture palette by selecting it from the pencil texture palette list in the
Colour view—see Colour View on page 235.

Chalk  Charcoal Rough @ Felt R..

Felt Gradient.. Grain  Bumpy.. Bumpy_...

B — et A N
Bumpy_.. Dash  Dash_Soft Dots  Grain_5q...

VY > Y

Grain_5q... Long_Br.. Long_Br... Ropy | Ropy_Soft
I e P e T
Square | Stringy  Stringy_.. Wiggly...

- v

Description

This option is available from the menu = button. Sets the currently
selected pencil texture palette as the default pencil texture palette in your
Use as Default Pencil user preferences. The default pencil texture palette is added to every scene
Texture Palette you create in Harmony. The palette is copied in your preferences, so it will
be added to your new scenes in the exact state it is when you make it the

i

default pencil texture palette.

Imports the default pencil texture palette as a new pencil texture palette
Reload Default Texture

Palette

fu

into your scene's palette list, and selects it as the current pencil texture
palette.

Allows you to import an image file into a new pencil texture swatch in the
current pencil texture palette. The pencil texture's effect on your pencil line
+ New Texture will be based on the image's transparency channel, and will follow your
pencil lines on its horizontal axis. This option is also available from the

menu = button.
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Description

Delete Texture

Deletes a pencil texture swatch from the current pencil texture palette.

This option is also available from the menu = button.

Rename Texture

Renames the selected pencil texture swatch in the current pencil texture
palette. This option is also available from the menu = button.

Pencil Texture Display

Displays the pencil textures in the current pencil texture palette and allows
you to select one to use with the Pencil tool.

Pencil Texture Palette

Displays the name of the currently selected pencil texture palette, for
reference. To select a different pencil texture palette, you must select itin
the Colour view—see Colour View on page 235.
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Pencil Editor Tool Properties

When you select the Pencil Editor tool, its properties and options appear in the Tool Properties view.

Tapered Thickness Stencil
12 X

Tapered Beginning Thickne...
12 X

Tapered End Thickness Ste...
12 X

Medium Tapered Thicknes...
12 X

Pointy Pencil Thickness Ste...
12 X

Fat Ends Thickness Stencil
12 X

Curved Above Thickness St...

Chalk  Charcoal  Rough

Gradient.. Grain  Bumpy...
ORI i 1 AN
Bumpy_... Dash Dash_Soft Dots
WY e —

Grain_5q... Long_Br... Long_Br.., Ropy

Felt_R...

Bumpy_...

SRR e

Grain_5q...
i

Ropy_Soft

Ui ity st PRI P WY

Spots Square  Stringy  Stringy_...
- v e

Wiggly...

Icon Tool Name

Description

Selection Mode

Allows you to choose the method to visually select multiple elements:

. Lasso: Allows you to select multiple elements by drawing an
irregular closed shape around them with your mouse.

« [xI Marquee: Allows you to select multiple elements by drawing a
rectangle around them. This is faster, as you only need to drag
your mouse from one corner of the rectangle to its opposite
corner, but it may not be as precise as you want.
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[}
.‘Q’. TIP
4 \
You can press and hold the Alt key to temporarily use the other
selection mode.

il

Apply to Visible Drawing
Layers

This option allows you to select which layers the tool should affect. It can
be toggled on or off. When toggled on, it has two different modes. You
can select a mode by clicking and holding on the button.

« Off: When this button is toggled off, the tool only works on the
currently selected layers. If several layers are selected, the tool will
work on all these layers simultaneously.

« [l Apply to Visible Drawing Layers: The tool will work on all the
visible layers in the Camera view.

« ! Apply to Synced Drawing Layers: If the currently selected
layer is synced with another layer, the tool will work on both the
current layer and its synced layer.

NOTE

This option only works in the Camera view.

Maximum Size

Defines the maximum width of the pencil line.

If the pencil line has a constant size, this will define the width of the
pencil line all over. If the pencil line has a varying size, this will define the
width of its larger areas. Areas that are in-between the maximum and
minimum size will be resized proportionally.

Minimum Size

Defines the minimum width of the pencil line. If the pencil line has a
varying size, this will define the width of its smaller areas. Areas that are
in-betwen the maximum and minimum size will be resized proportionally.

Shape

You can adjust the start, end, and join style of a pencil line.

« Start: Lets you select the style of the start tip, which is the first tip
you drew. You can choose between Round or Flat style.

« End: Lets you select the style of the end tip, which is the last tip
you drew. You can choose between Round or Flat style.
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« Join: Lets you select the joint style. The joints are where the line
curves abruptly. You could also define the Join style as the corner
style. You can choose between Round, Mitre and Bevel style.

Harmony provides a variety of pencil presets and thickness stencils and
also lets you create and save your own. It is a good idea to create and
save pencils with precise sizes and parameters when you draw for
efficiency and consistency.

A thickness stencil saves the thickness information across the length of
the line. When drawing with a thickness stencil, the pressure sensitivity
of the tablet is discarded. A thickness stencil can be used while drawing,

Presets
or applied afterwards.
You also have the possibility to apply different textures to your lines by
either using the default presets or to import your own.
You can export the pencil presets that you have created and import those
that others have created. This is a good way for you and project
collaborators to keep a consistent look for the project.
K 4 New Brush Allows to create a new preset from the selected pencil line.
K . Delete Brush Deletes the currently selected preset.
Rename Brush Allows you to rename the currently selected preset.
Small Thumbnail, Large . .
. Allows you to display the presets as small square thumbnails, large
Thumbnail, and Stroke ] ) .
. square thumbnails or a list of stroke preview.
View
This option is available from the menu = button. Sets the currently
selected pencil texture palette as the default pencil texture palette in your
E)j Use as Default Pencil user preferences. The default pencil texture palette is added to every
Texture Palette scene you create in Harmony. The palette is copied in your preferences, so
it will be added to your new scenes in the exact state it is when you make
it the default pencil texture palette.
Imports the default pencil texture palette as a new pencil texture palette
7 Reload Default Texture . . . .
cH into your scene's palette list, and selects it as the current pencil texture

Palette

palette.

New Texture

Adds a new custom pencil texture to the list.
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Delete Texture

Deletes a texture preset from the list.

Rename Texture

Renames the selected texture to keep the list organized.

Presets

Harmony provides a variety of pencil texture presets and also lets you
create and save your own.

Pencil Texture Palette

Displays the colour palette assigned to hold the pencil textures. Use the
Colour View menu to assign a new palette.

7 Smooth Selection

The Smooth operation lets you smooth out selected drawing strokes and
remove extra points.

TIP

You can also smooth the selection by selecting Selected >
Smooth from the top menu or by pressing Alt + Shift + S.

Pump Pencil Pressure

The Pump Pencil Pressure option is used to increase the line thickness of
a selected area on a pencil line.

Deflate Pencil Pressure

The Deflate Pencil Pressure option is used to decrease the line thickness
of a selected area on a pencil line.
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Merge Pencil Lines

Because pencil lines are defined by their centre lines, two pencil lines that
brush against each other may not actually make a closed shape, even if
they appear closed. If you select several pencil lines that are close
together, you can use this button to close the small gaps between these

pencil lines and make them into a single pencil line.

0

2

Reverse Pencil Thickness

The Reverse Pencil Thickness option inverts the thick and thin section on
a selected pencil line. This option will take the thickest size on the line
and apply it to the thinnest, and it will apply the thinnest to the thickest.

< Thick

Thick -
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Perspective Tool Properties
The perspective tool allows you to deform artwork by creating a rectangular bounding box around it and
allowing you to manipulate any of the four corners. The selected artwork will be deformed to fit the shape you
make by simulating a perspective effect.

How to access the Perspective tool properties

1. Inthe Tools toolbar, select the Perspective 21 tool.

The tool's properties are displayed in the Tool Properties view.

Tool Properties =%

Tool Name Description

Perspective Tool Options

Allows you to choose the method to visually select multiple elements:

o Lasso: Allows you to select multiple elements by drawing an
irregular closed shape around them with your mouse.

« I\ Marquee: Allows you to select multiple elements by drawing a
rectangle around them. This is faster, as you only need to drag
your mouse from one corner of the rectangle to its opposite
corner, but it may not be as precise as you want.

.‘Q'. TIP

You can press and hold the Alt key to temporarily use the other
selection mode.

Selection Mode

Allows you to enable or disable snapping for this tool and all other
animation and drawing tools that support snapping, as well as to select

@ Snapping which types of snapping are enabled.

If you double-click or long-click on this button, it will open a pop-up
menu in which you can toggle different snapping modes. You can also
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Icon Tool Name Description

click on this button to toggle it off, which will disable all snapping
modes, and click on it again and toggle it on to re-enable the snapping
modes which were previously enabled.

This tool supports the following snapping modes:

« Snap to Contour: While moving the selection or one of its
control points, it will snap against the nearby points and
contours of your artwork, allowing you to snap parts of your
artwork together.

« Snap to Alignment Guides: While moving the selection or one of
its control points, it will snap against nearby alignment guides.

« Snap and Align: When enabled, while moving a selection, the
rectangular bounding box of the selection will snap to the
rectangular bounding box of any other drawing stroke in the
drawing, allowing you to align drawing strokes laterally.

o Snap to Grid: While moving the selection, the mouse cursor will
snap against the intersecting points of the grid.

[}
.‘Q'. TIP
’ N\
To display the grid, select View > Grid > Show Grid
from the top menu or press Ctrl +".

Allows you to perform drawing operations on both the Line Art and
Colour Art layers of your drawing simultaneously.

? Apply to Line and Colour

Art 9) NOTE

If you have Overlay and Underlay Art layers enabled, they will
also be affected when this option is enabled.

Allows you to select between one of the two following deformation
modes:

« /R Perspective: Deforms the selection by simulating a
perspective effect.

ﬁﬁ Deformation Mode « /R Lattice: Deforms the selection by simply making the artwork

fit the bounding box, without applying a perspective effect.

The difference between both modes becomes easier to understand if you
apply a transformation to a drawing of a grid to make it look like it's laid
down on a surface:

168



Harmony 20 Paint Reference Guide

Icon Tool Name

Description

Crignal shape Deformed with Perspective Mode

Deformed with Lattice Mode

Operations
<”[> Flip Horizontal Flips the selection horizontally.
PN
< Flip Vertical Flips the selection vertically.
@’ Rotate 90 CW Rotates the selection 90° clockwise.
@ Rotate 90 CCW Rotates the selection 90° counterclockwise.
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Polyline Tool Properties

The Polyline tool allows you to draw complex lines or shapes by defining each point and their Bezier handles
one by one.

How to access the Polyline tool properties

1. Inthe Tools toolbar, select the Polyline G tool.

The tool's properties are displayed in the Tool Properties view.

Tool Properties == |

Pencil 2 Pencil 3 |Fixed Thick...

10 20 2
Fixed Thick...| Charcoal |Tapered Th...| Tapered Be...

25 12 & |12 X
... |Medium Ta...| Pointy Pen... |Fat Ends Th...

12 K| 12 X
.. | Curved Bel... |Uniform Th...

Pencil Properties

Just like other shape tools, this tool creates pencil lines. Hence, its tool properties are similar to the ones of the
Pencil tool and it can be used with pencil presets.

Icon Property Description

The Preview area lets you see a preview of the stroke your drawing tool
will make.

Preview Area

. /\/ I
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The arrow button right of the preview area opens the Pencil Properties
dialog.

. /\_/ u

Pencil Properties

Dialog
While the Tool Properties view only gives you access to the pencil size, a

list of pencil presets and other drawing options, the Pencil Properties
dialog gives you access to all the available options for your pencil's shape
and texture. For more information on the Pencil Properties dialog, see the
Polyline Tool Properties section below.

Size Defines the width of the pencil line used to draw the shape.

Pencil Presets

Icon Property Description
Harmony provides a variety of presets and also lets you create and save
your own. ltis a good idea to create and save pencils with precise sizes
and parameters when you draw and design for efficiency and
Presets list consistency.
All tools using pencil lines share the same preset list. Therefore, the
Polyline, Line, Rectangle, Ellipse, and Pencil tools share the same preset
list.
* New Preset Creates a new preset based on the current tool properties.
b Delete Preset Deletes the currently selected preset.
E, Presets Menu Gives access to more options for managing presets.
Rename Brush Allows you to rename the currently selected preset.
Import Brushes Allows you to import brush presets exported from Harmony.
Export Brushes Allows you to export your brush presets into an .xml file.
Small Thumbnail Displays presets in a grid of small thumbnails with a preview of their tip.
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. Displays presets in a grid of big thumbnails, with their name and a
Large Thumbnail . "
preview of their tip.

. Displays presets in a list, with their name and a preview of a stroke done
Stroke View .
with each preset.

Drawing Options

Icon Property Description

When this option is enabled, clicking close to a contour in your drawing
will add the point to that contour. The line you are building will be linked
to that contour.

If this option is disabled, attempting to click on existing contours will
-~ always create a point very close to that contour, but not exactly on it.
\ Snap to Contour Therefore, it is necessary to enable this mode if you want to create lines

that branch from into existing contours in your drawing.

NOTE

If you draw a line with the Line tool and make its tip snap to a
contour or another control point in your artwork, they will be
locked together. You can then manipulate both simultaneously
using the % Contour Editor tool. You can also separate two
drawing strokes that have been snapped together by selecting
one of them with the R Select tool and moving it away.

When enabled, drawing a closed shape will automatically fill it with the
currently selected Paint colour.

® Auto Fill
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TIP

By default the pencil line and its fill will be the same colour. To
select different colours for the line and its fill, do the following:

1. In the Colour view, click the < Unlock Three Colours
button.

2. Click onthe # Set Current Pencil Colour swatch. Then,
in the colour list, select the desired colour swatch for
your outline.

3. Click onthe ® Set Current Paint Colour swatch. Then,
in the colour list, select the desired colour swatch for the
fill.

Trim Extra Lines

When enabled, drawing a closed shape will automatically remove the
outstanding lines.

Align Handles After
Trim

When the Trim Extra Lines option is enabled, enable this option to make
the point where the beginning and end of the stroke meet into a smooth
curve rather than a hard corner.

Automatically Create
Colour Art

As you draw in the Line Art layer, the Automatically Create Colour Art
option instantly creates the corresponding strokes in the Colour Art layer.

<l

Auto-Flatten Mode

By default, when drawing on a vector layer, each new stroke is created as
a separate drawing object, which can be edited independently from other
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parts of the artwork. When enabled, the Auto-Flatten option
automatically merges strokes into existing artwork.

=\

NOTE

Using the Select tool, you can use select and remove a segment
of flattened pencil lines. Overlapping pencil lines drawn with the
Auto-Flatten mode are essentially cut into segments by the
overlap and can be treated as individual lines.

Pencil Properties Dialog

The Polyline tool draws the same type of line as the Pencil tool. Hence, you can configure the Polyline tool's
lines using the Pencil Properties dialog, which you can open by clicking on the arrow button right of the stroke

display area in the Tool Properties view.

Size and Smoothness Tab

The Size and Smoothness tab allows you to select your pencil's size, its smoothing parameters as well as the

shape of its tips and corners.
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Description

Maximum Size

Defines the maximum size of the pencil line. If the tool is used with a pressure
sensitive pen tablet, the width of the stroke will vary between its maximum size and
minimum size depending on the amount of pressure used. If used with a mouse, the
width of the stroke will always be its maximum size.

Minimum Size

Defines the minimum size of your stroke as a percentage of the maximum size. If you
do not have pressure sensitivity from a pen table, the minimum size value will be
ignored.

Proportional to Camera

If you check this option, the size of the pencil will be adjusted to the position of the
camera on the z-axis. This means that if the camera is zoomed in on the scene, the
pencil will be proportionally smaller so that it appears the same size in the rendered
image. Likewise, if the camera is zoomed out, the pencil will be proportionally bigger.

Centerline Smoothing

Defines the amount of smoothing Harmony should perform on the central line of the
pencil stroke. A higher setting will prevent your line from being shaky and will reduce
the amount of control points it has, making it easier to tweak, but is liable to reduce
drawing precision and turn sharp angles into curves.

Contour Smoothing

Defines the amount of smoothing Harmony should perform on the outer contour of
the pencil stroke.

A pencil line is defined by its centreline and its variations in thickness, rather than its
apparent shape. When drawing a pencil line with a mouse, its thickness is uniform.
Therefore, its outer contour does not have any control point, except at its extremities,
and no smoothing is required for its contour.

However, when drawing a pencil line with a pressure sensitive tablet, its contour will
have control points and Bezier curves to define the line's variations in thickness, and
thus smoothing must be performed on its contour. An increased contour smoothing
will reduce the amount of control points on the line's thickness and smoothen its
curves, but may affect the precision of the variations in line thickness.

Shape

You can adjust the start, end, and join style of a pencil line.

Shape ape Shape

o Start: Lets you select the style of the start tip, which is the first tip you drew.
You can choose between Round or Flat style.

« End: Lets you select the style of the end tip, which is the last tip you drew.
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Description

You can choose between Round or Flat style.

« Join: Lets you select the joint style. The joints are where the line curves
abruptly. You could also define the Join style as the corner style. You can
choose between Round, Mitre and Bevel style.

Texture Tab

In the Pencil Properties view, the Texture tab allows you to select a pencil texture from the currently selected
pencil texture palette to use with the Pencil tool. You can also add, remove or rename textures, save the current
pencil texture palette as the default one, or import the pencil texture palette into your scene.

The pencil texture palette used in the Texture tab of the Pencil Properties dialog is the one selected in the
Colour view. You can select a pencil texture palette by selecting it from the pencil texture palette list in the
Colour view—see Colour View on page 235.

Description

This option is available from the menu = button. Sets the currently
selected pencil texture palette as the default pencil texture palette in your
Use as Default Pencil user preferences. The default pencil texture palette is added to every scene
Texture Palette you create in Harmony. The palette is copied in your preferences, so it will
be added to your new scenes in the exact state it is when you make it the
default pencil texture palette.

i

176



Harmony 20 Paint Reference Guide

Description

g

Reload Default Texture
Palette

Imports the default pencil texture palette as a new pencil texture palette
into your scene's palette list, and selects it as the current pencil texture
palette.

New Texture

Allows you to import an image file into a new pencil texture swatch in the
current pencil texture palette. The pencil texture's effect on your pencil line
will be based on the image's transparency channel, and will follow your
pencil lines on its horizontal axis. This option is also available from the
menu = button.

Delete Texture

Deletes a pencil texture swatch from the current pencil texture palette.
This option is also available from the menu = button.

Rename Texture

Renames the selected pencil texture swatch in the current pencil texture
palette. This option is also available from the menu = button.

Pencil Texture Display

Displays the pencil textures in the current pencil texture palette and allows
you to select one to use with the Pencil tool.

Pencil Texture Palette

Displays the name of the currently selected pencil texture palette, for
reference. To select a different pencil texture palette, you must select itin
the Colour view—see Colour View on page 235.

L

@ NOTE
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Rectangle Tool Properties

The Rectangle tool allows you to quickly draw a rectangle or a square.

How to access the Rectangle tool properties

1. Inthe Tools toolbar, select the Rectangle [ tool.

The tool's properties are displayed in the Tool Properties view.

Tool Properties 4%

Pencil 2 Pencil 3 |Fixed Thick...
- L]

10 20 2
Charcoal | Tapered Thi...| Tapered Be...

25 12 K |12 %
Medium Ta...| Pointy Pen... |Fat Ends Th...

Pencil Properties

Just like other shape tools, this tool creates pencil lines. Hence, its tool properties are similar to the ones of the

Pencil tool and it can be used with pencil presets.

Description

The Preview area lets you see a preview of the stroke your drawing tool will make.

Preview Area —~— I

Pencil Properties . . . . .
Dial The arrow button right of the preview area opens the Pencil Properties dialog.
ialog
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Description

. /\-/ I

While the Tool Properties view only gives you access to a few of the pencil properties,
a list of pencil presets and other drawing options, the Pencil Properties dialog gives
you access to all the available options for your pencil's shape and texture. For more
information on the Pencil Properties dialog, see the Pencil Properties Dialog on page

183 section below.

Size Defines the width of the pencil line used to draw the shape.

You can adjust the start, end, and join style of a pencil line.

Shape « Start Lets you select the style of the start tip, which is the first tip you drew.

You can choose between Round or Flat style.

« End: Lets you select the style of the end tip, which is the last tip you drew. You
can choose between Round or Flat style.

« Join: Lets you select the joint style. The joints are where the line curves abruptly.
You could also define the Join style as the corner style. You can choose between
Round, Mitre and Bevel style.

Drawing Options

These options affect the way your shape is added to your artwork.

Property Description

When enabled, your brush strokes will appear behind the existing artwork.

The orange stroke was drawn
over the black stroke, then put
underneath it.

N Draw Behind
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Description

@ NOTE

Your brush stroke will temporarily appear over your artwork as you

draw it, until you release the mouse cursor or tablet pen.

When enabled, the shape you draw is automatically filled with the selected
colour. By default, drawing a shape only creates its outlines.

@ Auto Fill -‘Q- TIP

By default the pencil line and its fill will be the same colour. To
select different colours for the line and its fill, do the following:

1. Inthe Colour view, click the < Unlock Three Colours
button.

2. Click onthe # Set Current Pencil Colour swatch. Then,
in the colour list, select the desired colour swatch for your
outline.

3. Click onthe ® Set Current Paint Colour swatch. Then, in
the colour list, select the desired colour swatch for the fill.

Allows you to enable or disable snapping for this tool and all other
animation and drawing tools that support snapping, as well as to select
which types of snapping are enabled.

If you double-click or long-click on this button, it will open a pop-up menu
in which you can toggle different snapping modes. You can also click on
this button to toggle it off, which will disable all snapping modes, and click
@ on it again and toggle it on to re-enable the snapping modes which were

S .
napping previously enabled.

This tool supports the following snapping modes:

« Snap to Contour: When enabled, while you're drawing, the mouse
cursor will snap to the nearby contours of the artwork in your
drawing.

« Snap to Alignment Guides: While drawing, the drawing tool will
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Description

snap against nearby alignment guides.
« Snap and Align: When enabled, while you're drawing, the mouse
cursor will automatically align to the rectangular bounding boxes of

other strokes and shapes in your drawing.
« When enabled, while you're drawing, the mouse cursor will snap

against the intersecting points of the grid.

[}
.‘Q'. TIP
' d \
from the top menu or press Ctrl + .

To display the grid, select View > Grid > Show Grid

As you draw in the Line Art layer, the Automatically Create Colour Art

Automatically Create

/
é Colour Art

option instantly creates the corresponding strokes in the Colour Art layer

By default, when drawing on a vector layer, each new stroke is created as a

<l

Auto Flatten Mode

separate drawing object, which can be edited independently from other

parts of the artwork. When enabled, the Auto-Flatten option automatically

=N\

merges strokes into existing artwork.

i
Using the Select tool, you can use select and remove a segment of
flattened pencil lines. Overlapping pencil lines drawn with the
Auto-Flatten mode are essentially cut into segments by the

overlap and can be treated as individual lines.

The Use Stored Colour Gradient option can be used when painting with a

]
HE

Use Stored Colour

gradient colour to always position the gradient in the same way it was

Gradient
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Description

stored, making it consistent across brush strokes. You can store a gradient
by selecting a zone painted with a gradient with the Select tool, then
clicking on Store Colour Gradient D in the Tool Properties view.

When enabled, the rectangle tool will always draw a rectangle of equal
width and height, making it a perfect square.

q Draw Square _\Q'_ TIP

You can also draw a perfect square by holding the Shift key while
drawing.

Pencil Presets

These options allow you to select, create and manage pencil presets.

Description
Harmony provides a variety of pencil presets and thickness stencils and
also lets you create and save your own. It is a good idea to create and
save pencils with precise sizes and parameters when you draw for
efficiency and consistency.
A thickness stencil saves the thickness information across the length of
the line. When drawing with a thickness stencil, the pressure sensitivity
Presets list of the tablet is discarded. A thickness stencil can be used while drawing,
or applied afterwards.
You also have the possibility to apply different textures to your lines by
either using the default presets or to import your own.
You can export the pencil presets that you have created and import those
that others have created. This is a good way for you and project
collaborators to keep a consistent look for the project.
K New Brush Preset Creates a new preset based on the current tool properties.
K4 Delete Brush Preset Deletes the currently selected preset.
Open a menu that contains the following options:
= Brush Presets Menu
« New Brush Preset: Creates a new preset based on the current tool
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Description

properties.
« Delete Brush: Deletes the currently selected preset.

« Rename Brush: Allows you to rename the currently selected
preset.

« Import Brushes: Allows you to import brush presets exported
from Harmony.

« Export Brushes: Allows you to export your brush presets into an
.xml file.

« Small Thumbnail: Displays presets in a grid of small thumbnails
with a preview of their tip.

« Large Thumbnail: Displays presets in a grid of big thumbnails,
with their name and a preview of their tip.

« Stroke View: Displays presets in a list, with their name and a
preview of a stroke done with each preset.

Pencil Properties Dialog

The Rectangle tool draws the same type of line as the Pencil tool. Hence, you can configure the Rectangle tool's
lines using the Pencil Properties dialog, which you can open by clicking on the arrow button right of the stroke
display area in the Tool Properties view.

—

Size and Smoothness Tab

The Size and Smoothness tab allows you to select your pencil's size, its smoothing parameters as well as the
shape of its tips and corners.
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Description

Defines the maximum size of the pencil line. If the tool is used with a pressure

. . sensitive pen tablet, the width of the stroke will vary between its maximum size and
Maximum Size . . . .
minimum size depending on the amount of pressure used. If used with a mouse, the

width of the stroke will always be its maximum size.

Defines the minimum size of your stroke as a percentage of the maximum size. If you
Minimum Size do not have pressure sensitivity from a pen table, the minimum size value will be
ignored.

If you check this option, the size of the pencil will be adjusted to the position of the
. camera on the z-axis. This means that if the camera is zoomed in on the scene, the

Proportional to Camera I . . o
pencil will be proportionally smaller so that it appears the same size in the rendered

image. Likewise, if the camera is zoomed out, the pencil will be proportionally bigger.

Defines the amount of smoothing Harmony should perform on the central line of the
. . pencil stroke. A higher setting will prevent your line from being shaky and will reduce
Centerline Smoothing . . o . o
the amount of control points it has, making it easier to tweak, but is liable to reduce

drawing precision and turn sharp angles into curves.

Defines the amount of smoothing Harmony should perform on the outer contour of
the pencil stroke.

A pencil line is defined by its centreline and its variations in thickness, rather than its
apparent shape. When drawing a pencil line with a mouse, its thickness is uniform.
Therefore, its outer contour does not have any control point, except at its extremities,
and no smoothing is required for its contour.

Contour Smoothing

However, when drawing a pencil line with a pressure sensitive tablet, its contour will
have control points and Bezier curves to define the line's variations in thickness, and
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Description

thus smoothing must be performed on its contour. An increased contour smoothing
will reduce the amount of control points on the line's thickness and smoothen its
curves, but may affect the precision of the variations in line thickness.

You can adjust the start, end, and join style of a pencil line.

Shape « Start Lets you select the style of the start tip, which is the first tip you drew.

You can choose between Round or Flat style.

« End: Lets you select the style of the end tip, which is the last tip you drew.
You can choose between Round or Flat style.

« Join: Lets you select the joint style. The joints are where the line curves
abruptly. You could also define the Join style as the corner style. You can
choose between Round, Mitre and Bevel style.

Texture Tab

In the Pencil Properties view, the Texture tab allows you to select a pencil texture from the currently selected
pencil texture palette to use with the Pencil tool. You can also add, remove or rename textures, save the current
pencil texture palette as the default one, or import the pencil texture palette into your scene.

The pencil texture palette used in the Texture tab of the Pencil Properties dialog is the one selected in the
Colour view. You can select a pencil texture palette by selecting it from the pencil texture palette list in the
Colour view—see Colour View on page 235.
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Chalk  Charcoal Rough @ Felt R..
Gradient.. Grain  Bumpy.. Bumpy_...

Grain_ Sq

.| Long_Br...| Long_Br...

f 'll.' '-'| e G T T
Spots Square  Stringy  Stringy_...

BETT R Y ey N

Property Description

This option is available from the menu = button. Sets the currently
selected pencil texture palette as the default pencil texture palette in your

I’:'Ij Use as Default Pencil user preferences. The default pencil texture palette is added to every scene
Texture Palette you create in Harmony. The palette is copied in your preferences, so it will

be added to your new scenes in the exact state it is when you make it the
default pencil texture palette.
Imports the default pencil texture palette as a new pencil texture palette

7 Reload Default Texture . . . .

OH Palette into your scene's palette list, and selects it as the current pencil texture
palette.
Allows you to import an image file into a new pencil texture swatch in the
current pencil texture palette. The pencil texture's effect on your pencil line

+ New Texture will be based on the image's transparency channel, and will follow your

pencil lines on its horizontal axis. This option is also available from the
menu = button.

Deletes a pencil texture swatch from the current pencil texture palette.
Delete Texture ] . . _
This option is also available from the menu = button.

Renames the selected pencil texture swatch in the current pencil texture
Rename Texture . L . =
palette. This option is also available from the menu = button.

Pencil Texture Display Displays the pencil textures in the current pencil texture palette and allows
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Description

you to select one to use with the Pencil tool.

Displays the name of the currently selected pencil texture palette, for
Pencil Texture Palette reference. To select a different pencil texture palette, you must selectitin
the Colour view—see Colour View on page 235.
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Reposition All Drawings Tool Properties

When you use the Reposition All Drawings tool, its properties and options appear in the Tool Properties view.

Option Description
T E D When enabled, you can drag the selection by clicking anywhere inside its bounding
AN asy Dra
Y ° box. By default, you must click on the artwork in the selection to be able to drag it.
Apply to
N Synced If the currently selected layer is synced with another layer, the tool will work on both
N Drawing the current layer and its synced layer.
Layers
Operations

Option

Description

qp Flip Horizontal Flips the current selection horizontally.
@ Flip Vertical Flips the current selection vertically.
Rotate 90 . .
Rotates the current selection 90 degrees clockwise.
Degrees CW
Rotate 90

Degrees CCW

Rotates the current selection 90 degrees counter-clockwise.

Offset X and Y

Use the Offset X and Offset Y operation fields to enter specific values and
precisely reposition the selected shape.
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Description

1. X: Type avaluein this field to reposition your selection along the X-axis.
2. Y:Type avalue in this field to reposition your selection along the Y-axis.

3. Up/Down arrows: Use the up and down arrows to modify the value in the
X orY value field.

Use the Width and Height operation fields to enter specific values to resize the
selected shape with precision.

3
I $% |
2 — "
Width and
Height 1. Width: Type a value in this field to resize the width of your selection.
2. Height Type a value in this field to resize the height of your selection.
3. Up/Down arrows: Use the up and down arrows to modify the value in the
Width or Height fields.
4. Lockicon: Click the lock icon to lock or unlock the ratio between the
Width and Height values.
The Angle operation lets you to enter specific values and accurately rotate the
selected shape.
" — -
Angle

1. Angle: Type a degree value in this field to rotate your selection.

2. Up/Down arrows: Use the up and down arrows to modify the value in the

Angle value field.
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Select Tool Properties

The Select tool lets you select strokes and apply basic transformations such as repositioning, rotating, scaling or

skewing, using the different handles of the bounding box.

If you have text or pencil lines selected with the Select tool, their properties will display in the Tool Properties
view, allowing you to make changes to your selection.

How to access the Select tool properties

1. Inthe Tools toolbar, select either the Select & tool.

The tool's properties are displayed in the Tool Properties view.

190



Harmony 20 Paint Reference Guide

Tool Options

Property

Description

Selection Mode

Allows you to choose the method to visually select multiple elements:

. Lasso: Allows you to select multiple elements by drawing an
irregular closed shape around them with your mouse.

« [IxI' Marquee: Allows you to select multiple elements by drawing a
rectangle around them. This is faster, as you only need to drag
your mouse from one corner of the rectangle to its opposite corner,
but it may not be as precise as you want.

.‘Q'. TIP

You can press and hold the Alt key to temporarily use the other

selection mode.

AN Easy Drag

When enabled, you can drag the selection by clicking anywhere inside its
bounding box. By default, you must click on the artwork in the selection to
be able to drag it.

@ Snapping

Allows you to enable or disable snapping for this tool and all other
animation and drawing tools that support snapping, as well as to select
which types of snapping are enabled.

If you double-click or long-click on this button, it will open a pop-up
menu in which you can toggle different snapping modes. You can also
click on this button to toggle it off, which will disable all snapping modes,
and click on it again and toggle it on to re-enable the snapping modes
which were previously enabled.

This tool supports the following snapping modes:

« Snap to Contour: While moving the selection or one of its control
points, it will snap against the nearby points and contours of your
artwork, allowing you to snap parts of your artwork together.

« Snap to Alignment Guides: While moving the selection or one of
its control points, it will snap against nearby alignment guides.

« Snap and Align: While moving the selection, the rectangular
bounding box of the selection will align with the rectangular
bounding boxes of other strokes and shapes in your artwork. If
you move one of your selection's control points, it will also align
with the bounding boxes of other strokes and shapes in your
artwork.
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Icon Property Description

« Snap to Grid: While moving the selection, the mouse cursor will
snap against the intersecting points of the grid.

.‘Q'. TIP

To display the grid, select View > Grid > Show Grid
from the top menu or press Ctrl +".

When enabled, clicking on a coloured zone in your artwork will instantly
select all the zones that are filled with the same colour.

k Select by Colour

@ NOTE

Only the zones painted with the same colour swatch in your
palette will be selected. If another zone is coloured with the exact
same colour, but not the same colour swatch, it will not be
selected.

Allows you maintain a selection while editing multiple drawings. Once
2 Permanent Selection this option is enabled, the selection zone made using the Select tool will
remain as you navigate through drawings of the same layer and drawings
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Icon

Property

Description

from other drawing layers.

il

Apply to Visible Drawing
Layers

This option allows you to select which layers the tool should affect. It can
be toggled on or off. When toggled on, it has two different modes. You
can select a mode by clicking and holding on the button.

« Off: When this button is toggled off, the tool only works on the
currently selected layers. If several layers are selected, the tool will
work on all these layers simultaneously.

« [l Apply to Visible Drawing Layers: The tool will work on all the
visible layers in the Camera view.

« ! Apply to Synced Drawing Layers: If the currently selected layer
is synced with another layer, the tool will work on both the current
layer and its synced layer.

@ NOTE

This option only works in the Camera view.
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Icon Property Description

This option allows you to determine which drawings in the current layer
the tool should affect. It can be toggled on or off. When toggled on, it has
two different modes. You can select a mode by clicking and holding on the
button.

« Off: When this button is toggled off, the tool only works on the
drawing in the current frame.

. T Apply to All Frames: The tool will work on every exposed
drawing in the selected layer simultaneously.

. = Apply to Onion Skin Range: The tool will work on every
drawing displayed in the Onion Skin. Onion Skin must be enabled

&l

Apply to All Frames for this option to work.

Using the Apply to All Frames option, you can quickly remove the peg holes from a series of scanned
drawings.

Allows you to perform drawing operations on both the Line Art and
Colour Art layers of your drawing simultaneously.

g Apply to Line and Colour

Art @) NOTE

If you have Overlay and Underlay Art layers enabled, they will
also be affected when this option is enabled.

Operations
Icon Property Description
QI[} Flip Horizontal Flips the current selection horizontally.
=N
— Flip Vertical Flips the current selection vertically.
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Rotate 90 Degrees CW

Description

Rotates the current selection 90 degrees clockwise.

Rotate 90 Degrees CCW

Rotates the current selection 90 degrees counter-clockwise.

Smooth out selected drawing strokes and remove extra points.

Line Art

d Smooth
ﬁ-—
Merges drawing objects and brush strokes into a single layer. If you draw
new lines to fix a drawing or line with many brush strokes, it can be useful
to flatten them all into a single shape. By default, lines are drawn one on
top of each other. If you intend to repaint the lines or modify their shape, it
will be easier if they are flattened.
~ Flatten
Lets you use the outline you traced on one of the four embedded layers
(line art, colour art, overlay, underlay) and create invisible strokes to paint
Create Colour Art from your drawings on separate layers. This provides more inking and painting
N2

flexibility.

You can also configure this option to create the invisible strokes on any of
the four embedded layers.

Store Colour Gradient

Use the Store Colour Gradient operation to record the selected gradient’s
position. This reuses the stored position of the gradient when drawing
new brush lines or painting colour zones. Enable the Use Stored Colour
Gradient £ option in the Paint or Brush Tool Properties view to do this.
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Description

Converts the selected centre line pencil strokes into contour strokes brush

lines.

)9 Pencil to Brush L

Because pencil lines are defined by their centre lines, two pencil lines that
brush against each other may not actually make a closed shape, even if
they appear closed. If you select several pencil lines that are close
together, you can use this button to close the small gaps between these

pencil lines and make them into a single pencil line.

3? Merge Pencil Lines

@ NOTE
Points must be close enough to be merged. If there is a large gap

between the lines, they will not be merged.

The Reverse Pencil Thickness option inverts the thick and thin section on
a selected pencil line. This option will take the thickest size on the line and
apply it to the thinnest, and it will apply the thinnest to the thickest.

< Thick

§

Reverse Pencil Thickness

Thick
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Description

.>_<. Offset X Lets you enter a value to reposition the selection along the X-axis.

Y4 Offset Y Lets you enter a value to reposition the selection along the Y-axis.

o Width Lets you enter a value to resize the width of the selection.

0t Height Lets you enter a value to resize the height of the selection.

] Lock Locks or unlocks the ratio between the Width and Height values.

Lets you enter specific values to rotate the selection. A positive value

@ Angle rotates the selection counter clockwise and a negative value rotates the
selection clockwise.

Pencil Selection

If the selection contains pencil lines, the Pencil Selection section appears at the bottom of the Tool Properties
view, allowing you to adjust the properties of those pencil lines.

Tapered Beginning Thickness St...
12 X

Tapered End Thickness Stencil
12 X

Mediurm Tapered Thickness Ste...

Chalk  Charcoal Rough @ Felt R..

Gradient..  Grain  Bumpy.. Bumpy_..

SRR e

Dots  Grain_5q...

197



Chapter 2: Tools Properties

Property

Maximum Size

Description

Adjusts the size of the parts of the pencil lines that are the thickest. Parts
of the pencil lines that are between the minimum and maximum sizes will
be adjusted proportionally.

Minimum Size

Adjusts the size of the parts of the pencil lines that are the thinnest. Parts
of the pencil lines that are between the minimum and maximum sizes will
be adjusted proportionally.

Pencil Line Shape

You can adjust the start, end, and join style of a pencil line.

« Start Lets you select the style of the start tip, which is the first tip
you drew. You can choose between Round or Flat style.

« End: Lets you select the style of the end tip, which is the last tip
you drew. You can choose between Round or Flat style.

« Join: Lets you select the joint style. The joints are where the line
curves abruptly. You could also define the Join style as the corner
style. You can choose between Round, Mitre and Bevel style.

Pencil Stencils

Allows you to apply one of the available line thickness stencils to the
selected pencil lines. Stencils set the width of a pencil lines all along its
length. You can use one of the preloaded presets, or create your own
pencil stencils.

Adding Texture to a
Pencil Line

Pencil lines support texture. Once a pencil line is drawn, you can apply a
preset texture or load your own. Textures are independent from pencil
stencils.
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Text Selection

If your selection include text boxes created with the Text tool, a Text Selection section will appear at the bottom
of the Tool Properties view, allowing you to adjust the formatting of the whole text box.

NS TIP

e’ ~

You can also adjust the formatting of parts of the text in the text box using the Text tool—see Text
Tool Properties on page 217.

Description

Lets you select the font in which to display the text.

Vivaldi Copperplate Gothic Light
Font \

ol Dr ¥ MY PROJECT

Makes the selected text bold.

B | o My Project

Makes the selected text italic.

{ Italic

My Project

Align Left Aligns the text in the selected text box to the left.
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Description

LOREM IPSUM DOLOR SIT AMET,
CONSECTETUR ADIPISCING
ELIT. AENEAN VESTIBULUM,
METUS AC FERMENTUM
PORTTITOR, ODIO TURPIS
PORTTITOR NIBH, ID
CONSEQUAT MAGNA LIGULA ET
ELIT. CURABITUR SOLLICITUDIN
ELIT AC LOREM MOLLIS ACC
UMSAN.

Aligns the text in the selected text box to the centre.

LOREM IPSUM DOLOR SIT AMET,
CONSECTETUR ADIPISCING
ELIT. AENEAN VESTIBULUM,

Align Center METUS AC FERMENTUM

PORTTITOR, ODIO TURPIS
PORTTITOR NIBH, ID

CONSEQUAT MAGNA LIGULA ET

ELIT. CURABITUR SOLLICITUDIN
ELIT AC LOREM MOLLIS ACC

UMSAN.

Aligns the text in the selected text box to the right.

LOREM IPSUM DOLOR SIT AMET,
CONSECTETUR ADIPISCING
ELIT. AENEAN VESTIBULUM,

. . METUS AC FERMENTUM

Align Right PORTTITOR, ODIO TURFIS

PORTTITOR NIBH, ID

CONSEQUAT MAGNA LIGULA ET

ELIT. CURABITUR SOLLICITUDIN
ELIT AC LOREM MOLLIS ACC
UMSAN.

Makes the text in the selected text box take all the horizontal space by
adjusting the spacing between each word. Text that use a single line and
text in the last line of a paragraph is aligned to the left.

LOREM IPSUM DOLOR SIT AMET,

. CONSECTETUR ADIPISCING
Justify ELIT. AENEAN VESTIBULUM,
METUS AC FERMENTUM
PORTTITOR, ODIO TURPIS
PORTTITOR NIBH, 1D
CONSEQUAT MAGNA LIGULA ET
ELIT. CURABITUR SOLLICITUDIN
ELIT AC LOREM MOLLIS ACC
UMSAN.

Allows you to set the size of the selected text.

Size

small text big teXt
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Description
Allows you to increase or decrease the spacing between each character.
Lorem ipsum dolor Lorem ipsum dolor sit amet,
sit amet, consectetur consectetur adipiscing elit.
adipiscing elit. Aenean vestibulum, metus ac
Aenean vestibulum, fermentum porttitor, odio turpis
. metus ac fermentum porttitor nibh, id consequat
Kernlng porttitor, odio turpis magna ligula et elit. Curabitur
porttitor nibh, id sollicitudin elit ac lorem mollis
consequat magna acc umsan.
ligula et elit.
Curabitur
sollicitudin elit ac
lorem mollis acc
umsan.

Auto Kern Sets the kerning automatically based on the font’s predefined standard.
Allows you to increase or decrease the indentation of the first line of text
in each paragraph.

Lorem ipsum dolor sit amet, Lorem ipsum dolor sit amet,

Indent consectetur adipiscing elit. Aenean consectetur adipiscing elit. Aenean

vestibulum, metus ac fermentum stibulum, metus ac f tum
porttitor, odio turpis porttitor nibh, id porttitor, odio turpis porttitor nibh, id
consequat magna ligula et elit. consequat magna ligula et elit
Curabitur sollicitudin elit ac lorem Curabitur sollicitudin elit ac lorem
mollis acc umsan. mollis acc umsan.
Increases or decreases the space between each line of text.
Lorem ipsum dolor sit amet, Lorem ipsum dolor sit amet,
consectetur adipiscing elit Aenean consectetur adipiscing efit. Aenean
" * ac fermentum vestibulum, metus ac fermentum
Line Spacing portitor, odio turpis porttitor nibh, id : ' . mentum
consequat magna ligula et _elit. porttitor, odio turpis porttitor nibh, id
Curabitur sollicitudin elit ac lorem y
mmiollis acc umsan. consequat magna ligula et elit.
Curabitur sollicitudin elit ac lorem
mollis acc umsan.
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Shift and Trace Tool Properties

The Shift and Trace tool allows you to temporarily move, rotate and scale drawings, then trace over them in
other drawings, using Onion Skin to keep the outlines of the shifted drawings in your drawing space. Contrary
to Shift and Trace with the Drawing Desk, you can use the Shift and Trace tool in the Camera view.

How to access the Shift and Trace Tool Properties

1. Doone of the following:

e In the Tools toolbar, double-click on the Hand % tool and select Shift and Trace “w in the
pop-up menu.

o Inthe top menu, select Drawing > Drawing Tools > Shift and Trace.

The Shift and Trace tool properties appear in the Tool Properties view.

Icon Tool Name Description
Shift and Trace Tool Options

- Enable/Disable Enabled by default. When disabled, drawings that were repositioned, rotated or

~ Shift and Trace scaled with the Shift and Trace tool appear in their original position.
Display Cross Enabled by default. When disabled, cross hairs added with the Shift and Trace
Hair tool are invisible.

— Show Enabled by default. This displays the manipulator allowing you to rotate and scale

©7 manipulators drawings for Shift and Trace, as well as to re-position their pivot point. When
for shift and hidden, you can only shift drawings laterally.
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Tool Name Description
trace
Show the
outline of the . .
. When enabled, the contours of each brush stroke for the current drawing will
O selected shift L .
appear highlighted in cyan.
and trace
drawing
Enabled by default. When using the Shift and Trace tool, peg holes are displayed
Show/Hid at the bottom of every drawing to help keep track of how offset drawings are from
ow/Hide
== P their original position and from each other. You can also click and drag on the left
egs
9 or right peg hole of a drawing to rotate it around the centre peg hole. When
disabled, those peg holes are hidden.
» Allows you to select on which edge of the drawings to display peg holes. By
— Peg Position . .
default, they are displayed at the bottom of the drawings.

Modes and Operations

When selected, clicking on the drawing will add a cross hair where you click.
Cross hairs are marks that appear on the same location on every drawing in the

Set Add Cross . . . .

Hair Mode current layer and which move when you offset a drawing with the Shift and Trace

i
tool, and they appear in the Onion Skin rendition of neighbouring drawings as
well. This allows you to keep track of h